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Mission Statement 

The Crafton Hills College mission is to change lives. We seek to inspire our students, support 

our colleagues, and embrace our community through a learning environment that is 

transformational. Crafton Hills College welcomes everyone and is committed to working with 

students from diverse backgrounds. The College has an exceptional learning environment built 

on a tradition of excellence, a talented faculty, a driven student body, a committed staff, with 

passionate leadership and community support. 

 

Vision Statement 

To empower the people who study here, the people who work here, and the people who live in 

our community through education, engagement, and innovation. 

 

Institutional Values 

We rely on the following values to support our vision and mission: 

• Respect: To champion active listening and open dialogue within our community. 

• Integrity: To uphold honesty in our interactions and academic pursuits and maintain 

community collaboration. 

• Diversity & Inclusion: To promote a welcoming environment through equitable and 

antiracist practices in all aspects of our work. 

• Innovation: To actively grow and adapt to support our mission and vision through a 

willingness to embrace new perspectives and new ideas. 

• Leadership: To develop and inspire current and future leaders through professional 

development, mentorship, education, and experience. 

• Sustainability: To be a leader in our community by reducing environmental impact with 

practices that meet the needs of the present without compromising the future. 

 

Curriculum Accessibility Statement 

Crafton Hills College is committed to guaranteeing accessibility within its curriculum and 

advancing equitable student outcomes for all learners. Guided by the principles of Universal 

Design for Learning (UDL) and our commitment to DEIAA, our curriculum is designed to 

accommodate and engage diverse students through accessible course design, instructional 

materials, and assessments. This design ensures that the intensity, scope, and rigor of college-

level coursework—including critical thinking, vocabulary allocation, and complex concepts—

remain robust while being accessible to all. 

Through ongoing review and continuous improvement, Crafton Hills College strives to promote 

inclusion, foster belonging, and ensure meaningful access that supports every student’s 

success. 
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Preface 

This User Guide is a practical resource for developing and maintaining the curriculum here at 

Crafton Hills College. It is meant to help faculty and staff balance the technical requirements of 

academic standards with our primary goal: providing a life-changing education for our students. 

As we adapt to new educational needs, this document brings together Title 5 regulations and 

our own commitment to student success. Our goal is to create a framework for courses that 

don't just meet high standards for intensity, scope, and college-level rigor, but also reflect our 

deep-seated values of Diversity, Equity, Inclusion, Accessibility, and Antiracism (DEIAA). 

By leaning into Universal Design for Learning (UDL), we make sure our courses remain 

challenging—requiring critical thinking, high-level vocabulary, and complex conceptual work—

while ensuring those challenges are accessible to every student. This handbook is a living 

resource that reflects our ongoing work to lead with innovation and remove the barriers that 

stand in the way of student achievement. 

 

Using This User Guide 

We’ve designed this User Guide to be a functional, clickable resource rather than a static 

document. Throughout the various guides, you will find embedded links that take you directly to 

specific sections for deeper exploration. 

As you navigate the curriculum process, keep an eye out for these: 

• Step-by-Step Guides:  

o Directions for the Originator (Author) explaining each section in CurriQunet, 

including guidance on how to complete the proposal and move it through the 

approval process. 

o Directions for Curriculum Committee Members detailing what to Review for 

proposals and modifications and how to make comments to the originator. 

• Hyperlinks throughout for easier navigation and directions. 

• How to use the CurriQunet Outline Tool 

• Example phrasing:  

o Catalog Description 

o Need for Course 

o Goals for Course  

o Student Learning Outcomes 

o Typical Out-of-Class Reading and Writing Assignments  

o Course Materials and OER 

• Title 5 Lexicon Reference: A quick reference for integrating required Title 5 terminology 

into course outlines. 

• The Principles of Universal Design for Learning (UDL) and DEIAA in the Curriculum 
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The Course Outline of Record (COR): Ownership & Framework 

1. Departmental Ownership vs. Individual Authorship 

The Course Outline of Record (COR) is a legal document approved by the Curriculum 

Committee and the District Governing Board. While a faculty member acts as the originator 

(author) during development, the originator does not have sole rights to the COR. 

The COR is a departmental document written for the program, not a specific person. It serves 

as the official blueprint for the course; any instructor teaching the course must use the COR as 

their primary guide to ensure curricular consistency and equity. 

2. The Instructional Core: Content, Objectives, and SLOs 

To maintain compliance with Title 5, every instructor must strictly adhere to these three "fixed" 

elements, which are functionally linked through the course content: 

• Course Content (The "What"): The specific body of knowledge and topics that must be 

taught. Content is the central link; it provides the substance through which Objectives 

and SLOs are realized. 

• Objectives (The "How Content is Achieved"): The discrete skills and building blocks 

students master while engaging with the content. 

• Student Learning Outcomes (The "Evidence of Mastery"): The overarching goals 

that measure how effectively a student has mastered the content. 

3. Academic Freedom & Representative Elements 

While the core elements above are fixed, other sections of the COR serve as 

recommendations and examples. Academic freedom allows instructors the professional 

autonomy to adapt these areas: 

COR Element Flexibility & Academic Freedom 

Methods of Instruction 
Typical examples provided; instructors choose the pedagogical 
style that best delivers the content. 

Methods of Evaluation 
Examples of assessment; instructors design their own specific 
assignments and rubrics to measure the Objectives and SLOs. 

Course Materials 
Representative texts are listed; instructors may select equivalent 
college-level materials that cover the required Content. 

Typical Assignments 
Typical outside-of-class assignments are examples; instructors 
may create unique tasks to reinforce learning. 

UDL & DEIAA 
Recommended strategies for Diversity, Equity, Inclusion, 
Accessibility, & Anti-Racism and Universal Design for Learning 
should be integrated into the instructor’s unique course design. 

Modality (DE) 

For Distance Education, the COR provides the framework, but 
instructors choose specific digital tools and engagement 
strategies. All DE offerings must adhere to RSI (Regular and 
Substantive Interaction) requirements. For fully online courses 
instruction is asynchronous, no required scheduled meetings 
(including Zoom). 
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Part 1: CurriQunet Navigation and Proposal Guides 

Part 1.A. How to Start in CurriQunet 

Log into CurriQunet using your campus credentials to access your Dashboard. 

A.1. New Course Proposal (COR)
• Preparation: Check for available course numbers with the Instructional Services Analyst.

• Step 1: Click Create New Proposal  select New Course > Create. 

• Step 2: Refer to the CurriQunet Guide - New Course COR Proposal for complete

instructions.

A.2. New Honors Course Proposal (COR)
• Preparation: You must have an approved, Active base course before starting. Honors

versions are created by cloning, not by starting a new proposal.

• Step 1: Search for the base course under Curriculum > Course.

• Step 2: Select Clone  choose New Course - Honors > Create. 

• Step 3: Refer to the CurriQunet Guide - New Honors Course COR Proposal for complete

instructions.

A.3. Course Modifications: Including 6-Year Revision, Honors, or DE-Only
• Step 1: Find Active version of the course under Curriculum > Course.

• Step 2: Select Modify choose Course Modification or Modify Course – 

Honors or DE Addition Only then click Create. 

• Step 3: For complete instructions refer to the:

o CurriQunet Guide - Course Modification COR Proposal

o CurriQunet Guide - Honors Course Modification Proposal

o CurriQunet Guide - DE only Addendum Proposal

A.4. New Program Proposal

• Step 1: Click Create New Proposal  select Program > Create. 

• Step 2: Refer to the CurriQunet Guide - CurriQunet Guide - New Program Proposal for

complete instructions.

A.5. Program Modification
• Step 1: Find Active version of the Program under Curriculum > Program

• Step 2: Select Modify choose Proposal type – Program Modification > Create.

• Step 3: For complete instructions refer to: CurriQunet Guide - Program Modification

https://craftonhills.curriqunet.com/
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Part 1.B. CurriQunet Guides for Completing COR and Program 

Proposals  

B.1 CurriQunet Guide – New Course COR Proposal 
 

Start Here: Initiate by clicking the Create New Proposal, select New Course, and click Create 

Ensure all content areas are current, accurate, and aligned with approved learning outcomes 
while intentionally reflecting UDL and DEIAA principles to accommodate and engage diverse 
students. All sections must demonstrate a consistent college-level difficulty, intensity, and rigor. 

C-ID Descriptors 

• Check to see if there is a C-ID Descriptor. CHC Catalog will show C-ID 
number for reference. Not all courses have a C-ID. 

• Go to C-ID Descriptors – Final for requirements. 

• Recommended: Following the C-ID Descriptor will help the course be 
approved by the State. 

CurriQunet Form Sections:  
• Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into 

course outlines. 

Cover 

Course Discipline, 
Number and Title 

Previous CHC Course numbers may not be 
used, check with Instructional Services Analyst 
for available course numbers. 

Short Ttile 
Can be same or different from title  
Example: Organic Chemistry → OCHEM 

1st Semester to be 
offered 

Select a fall semester two years away. 

Recommended Course 
Enrollment 

Course Caps: Check with agreed course cap 
with Dept. Chair, do not just make it up. 

Standalone course Select if this is a standalone course. 

Catalog Description 

Provide a brief overview of the course focus 
and scope. Clearly state what students will 
learn and do in the course. 

• For cross-listed courses, both disciplines 
must be listed in the Description (e.g. This 
course is offered as ETHS 141 and SOC 141). 

Schedule Description Will be the same as the Catalog Description. 

Need for the Course 

Justify why the college should offer the course 
to its students. Describe how the course fulfills 
program, degree, certificate, or transfer 
requirements. Reference student demand, 
enrollment trends. Title 5 Lexicon 

Goals for the Course 

Describe how the course supports the college 
mission by promoting academic excellence, 
critical thinking, lifelong learning, and transfer 
or career readiness. Title 5 Lexicon 

Does this course 
equate with a course 

taught at SBVC? 

Look at SBVC course outlines to see if it 
equates. 

http://www.c-id.net/descriptors/final
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Co-Contributors Only those in the same discipline can be a co-contributor. 

Cross Listed 
Course 

Reminder: Include both in Catalog Description. No other action. 
Curriculum Chair(s) will populate this section in CurriQunet. 

Units and Hours 
Select Course type. Answer if it has variable units. Check all the 
Instructional Categories that apply. Fill in Min Lecture Units then use the 
provided table to list Contact Hours and Out of Class Hours. 

Course Standards 
Grading Method: Select Pass/No Pass or Letter Grade. 
Scroll down to select any areas that apply. 

Content 
• Be sure to use CurriQunet Outlining Tool only to ensure proper 

format in COR. Do not paste in a Word “outlined format”, it will appear 
wrong in the COR PDF. 

Objectives 

• Use higher level Bloom’s Taxonomy 

• Click +Add button, select Objective then toggle to open the text box to 
type in objective. Select “Requires Critical Thinking” if it applies. 
Each Objective will be a separate entry. 

Entrance Skills 
• Click +Add, select Entrance Skill then select Entrance Skill Type. Each 

Entrance Skill will be a separate entry.  

Student Learning 
Outcomes (SLOs) 

Student Learning 
Outcomes (SLOs) 

• These are determined by the discipline. Use 

higher level Bloom’s Taxonomy 

• Click +Add, select Outcome then toggle to 
open. Fill in Outcome Text. Each Outcome will 
be a separate entry. 

General Education 
Outcomes (GEOs) 

Select appropriate area(s) more than one may 
be selected. 

Institutional Learning 
Outcomes (ILOs) 

Select appropriate area(s) more than one may 
be selected. 

Requisites 

• Prerequisite 
• Corequisite 
• Departmental 

Recommendations 
• Limitation on 

Enrollment (e.g. 
Performance tryout or 
audition 

• Click +Add, select New Requisite Type, then 
toggle to open. Select Requisite Type in the 
drop-down menu. Select Subject from the 
drop-down menu, then the Requisite Course. 
Requisite Comment is optional. Each 
Requisite will be a separate entry. 

Requisite 
Validation 

See message in CurriQunet if you have any issues with this section 

• Click +Add, select New Requisite Type then toggle to open. Select 
Requisite Course then Content Review Type.  

o Content to Content: Fill in both text boxes.  
o Entrance Skills to Objectives: Select all that apply. 
o Entrance Skills to Entrance Skills: Select all that apply.  

Methods of 
Evaluation 

• Click +Add, select New Evaluation Method, then toggle to open. Select 
Evaluation Method from the drop-down menu. Percents are optional, but 
if given ensure they add up to 100%. Each Evaluation Method will be a 
separate entry. 
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UDL and DEIAA 
Components will be automatically embedded into COR. Select Credit by 
Exam or Credit by Prior Learning if applicable. Use textbox for any 
additional UDL and DEIAA opportunities for this course. 

Course Materials 

Select recent instructional materials (published within 5 years) that align 
with the course's required rigor, difficulty, and intensity. Faculty are 
strongly encouraged to also adopt OER (list under Textbook or 'Other') to 
reduce student costs and enhance accessibility. Some disciplines have 
exceptions to recency requirements, such as classic or legacy works. 

Textbook: Click +Add, select Textbook, then toggle to open and complete 
all fields including “Show how course materials reflect equity”. Each 
Textbook will be a separate entry. 

• Follow the same procedure for adding Manual, Software, and Other 
Learning Materials. 

Typical Out-of-
Class 

Assignments 

Hours/ week on 
assignments outside of 

the class 

See the provided chart for reference on the 
number of hours to enter.  

3-unit lecture = 6-Outside of Class Hours. 

Some assignments 
require critical thinking 

Select if applicable. 

Reading (required) 

Writing (required) 

Other (optional) 

Provide assignments that align with Objectives, 
demonstrate rigor, intensity, critical thinking, 
and independent study. Include diverse UDL 
submission methods and associated evaluation 
criteria. Writing tips and example phrasing.  

Methods of 
Instruction 

After each selection, describe how it will support the course in terms of 
critical thinking, rigor, difficulty, level, intensity and reflect UDL and DEIAA.  
Select Emergency Remote Instruction. Only courses with special 
circumstances such as CTE are excluded from this. 

Distance Education Section 
1. Distance Education? Select "Yes" to open required fields. 
2. DE Course Cap: Enter the recommended enrollment (Typically45; verify with Dept. 

Chair). 
3. Formats: Select at least two (e.g., FO, PO, OPA). If choosing only one, provide an 

explanation in the text box. (e.g., All exams or all labs must be in person only). 
4. Part 2 (RSI) and Part 3 (Accessibility): These are auto-embedded; no action is 

needed unless specific discipline requirements require selecting "Other" and explaining. 

No action for General Education/Transfer and Course Articulation sections since they are 
not completed by the COR originator.  

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  
 

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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B.2 CurriQunet Guide - New Honors Course COR Proposal 
A base COR must be approved or in review before an Honors version can be created. 
Start Here: Find the Base Course, select Clone, choose New Course - Honors then Create. 

CurriQunet Form Sections 

Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Cover 

Course Discipline, 
Number and Title 

• Course Number: Add H to number 

• Course Titles: Add Honors to end of titles. 

1st Semester to be 
offered 

Select a semester fall or spring and year. 

Recommended Course 
Enrollment 

Course Caps: Check with agreed course cap 
with Dept. Chair, do not just make it up. 

Catalog Description Add: This is an Honors course. 

Schedule Description Will be the same as the Catalog Description. 

Honors Section 
Justification 

Can be as brief as this, or more detailed. 

• Students often want a [Discipline] class for 
honors credit. 

Does this course 
equate with a course 

taught at SBVC? 

Look at SBVC course outlines to see if it 
equates. 

Content 
Add Honors Specific Content such as: 

• Original Research in the Field of [Discipline] 
• Effectively present on a research project using appropriate media. 

Objectives 

Add Honors Specific Objective(s) using higher level Bloom’s Taxonomy.  
• Click +Add, select Objective then toggle to open the text box to type in 

objective. Select Requires Critical Thinking if it applies.  

Requisites 

Prerequisite: Acceptance into the College Honors Institute must be in 
Conditions of Enrollment Catalog View. If missing Click +Add > New Non-
Course Requirement: Toggle to open text box then type: “Prerequisite: 
Acceptance into the College Honors Institute”  

Typical Out-of-
Class 

Assignments 

Select Some assignments require critical thinking. Add Honors 
Assignment(s) that demonstrate rigor, intensity, and critical thinking. 
Include diverse UDL submission methods and associated evaluation 
criteria. Writing tips and example phrasing. 

Critical Thinking 
Skills 

Type in the Augmented Critical Thinking skills the honors student will 
develop. As an example, start with: As a result of completing the 
honors course, students will be able to… 

Enhanced 
Instructional 
Methodology 

Describe (in bullets) the ways to enhance assignments, evaluation 
methods, and textbooks and other instructional materials to support the 
honors level of this class. 

DE Check with Honors Coordinator to see if okay for DE. 

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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B.3 CurriQunet Guide - Course Modification Proposal (including Six-

Year Revisions) See B.4 for Honors Course Modifications & B.5 for DE Only Addendum. 

Start Here: Use Active COR. Select Modify, choose Course Modification and click Create. 

C-ID Descriptors 

• Check to see if there is a C-ID Descriptor. CHC Catalog will show C-ID 
number for reference. Not all courses have a C-ID. 

• Check C-ID Descriptors – Final for any requirement updates since the 
last COR revision. 

• Recommended: Following the C-ID Descriptor will help the course be 
approved by the State. 

CurriQunet Form Sections 

Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Cover  

Course Discipline, 
Number and Title 

Only the Curriculum Chair(s) can change these, 
the originator cannot. Short Title can be 
changed. 

1st Semester to be 
offered 

Select a semester fall or spring and a year. 

Recommended 
Course Enrollment 

Course Caps: Check with agreed course cap 
with Dept. Chair, do not just make it up. 

Standalone course Select if this is a standalone course. 

Catalog Description 
For cross-listed courses, both disciplines 
must be listed in the Description (e.g. This 
course is offered as ETHS 141 and SOC 141). 

Schedule Description Will be the same as the Catalog Description. 

Need for the Course 

• Justify why the college should offer the course; 
fulfills program, degree, certificate, or transfer 
requirements.  

• Check that course numbers are accurate and 
revise if needed.  

• Update all IGETC references to CalGETC. 

Goals for the Course 

Describe how the course supports the college 
mission by promoting academic excellence, 
critical thinking, lifelong learning, and transfer or 
career readiness. 

Rationale for course 
modifications 

State the reason for the proposed change. 
Examples: Six-year revision, Remove/Add 
perquisite [state course] 

Does this course 
equate with a course 

taught at SBVC? 

Look at SBVC course outlines to see if it 
equates. 

Co-Contributors Only those in the same discipline can be a co-contributor. 

Cross Listed 
Course 

Reminder: Include both in Catalog Description. No other action. 
Curriculum Chair(s) will populate this section in CurriQunet. 

Units and Hours Check to verify it is appropriate and all sections completed. 

Course Standards 
Grading Method: Select Pass/No Pass or Letter Grade. 
Scroll down to verify or select any areas that apply. 

http://www.c-id.net/descriptors/final
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Content 

Be sure to use CurriQunet Outlining Tool only to ensure proper 
format in COR. Do not paste in a Word “outlined format”, it will appear 
wrong in the COR PDF. 

Objectives 

• Use higher level Bloom’s Taxonomy 
• Click +Add button, select Objective then toggle to open the text box to 

type in objective. Select “Requires Critical Thinking” if it applies. 
Each Objective will be a separate entry. 

Entrance Skills 
Check to verify if it is still appropriate.  
• Click +Add, select Entrance Skill then select Entrance Skill type. Each 

Entrance Skill will be a separate entry. 

Student Learning 
Outcomes (SLOs) 

Student Learning 
Outcomes (SLOs) 

• These are determined by the discipline. Use 

higher level Bloom’s Taxonomy 

• Click +Add, select Outcome then toggle to 
open. Fill in Outcome Text. Each Outcome will 
be a separate entry. 

General Education 
Outcomes (GEOs) 

Select appropriate area(s) more than one may 
be selected. 

Institutional Learning 
Outcomes (ILOs) 

Select appropriate area(s) more than one may 
be selected. 

Requisites 

Be sure to check that Requisite Courses have not changed number or 
discipline code since last COR. 

• Prerequisite 

• Corequisite 

• Departmental 
Recommendations 

• Limitation on 
Enrollment  

• Click +Add, select New Requisite Type, then 
toggle to open. Select Requisite Type in the 
drop-down menu. Select Subject from the 
drop-down menu, then the Requisite Course. 
Requisite Comment is optional. Each 
Requisite will be a separate entry. 

Requisite 
Validation 

Legacy Entrance 
Skills 

Manually re-enter any valid legacy data, as it 
does not transfer to the outline. 

See message in CurriQunet if you have any issues with this section 

• Click +Add, select New Requisite Type then toggle to open. Select 
Requisite Course then Content Review Type.  

o Content to Content: Fill in both text boxes.  

o Entrance Skills to Objectives: Select all that apply. 

o Entrance Skills to Entrance Skills: Select all that apply. 

Methods of 
Evaluation 

Methods of 
Evaluation (legacy) 

Manually re-enter any valid legacy data, as it 
does not transfer to the outline. 

• Click +Add, select New Evaluation Method, then toggle to open. Select 
Evaluation Method from the drop-down menu. Percents are optional, 
but if given ensure they add up to 100%. Each Evaluation Method will 
be a separate entry. 

UDL and DEIAA 
Components will be automatically embedded into COR. Select Credit 
by Exam or Credit by Prior Learning if applicable. Use textbox for any 
additional UDL and DEIAA opportunities for this course. 
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Course Materials 

Select recent instructional materials (published within 5 years) that align 
with the course's required rigor, difficulty, and intensity. Faculty are 
strongly encouraged to also adopt OER (list under Textbook or 'Other') 
to reduce student costs and enhance accessibility. Some disciplines 
have exceptions to recency requirements, such as classic or legacy 
works. 

Textbook: Click +Add, select Textbook, then toggle to open and 
complete all fields including “Show how course materials reflect 
equity”. Each Textbook will be a separate entry. 

• Follow the same procedure for adding Manual, Software, and Other 
Learning Materials. 

Typical Out-of-
Class Assignments 

Hours per week on 
assignments outside 

of the class 

See the provided chart for reference on the 
number of hours to enter.  

3-unit lecture = 6-Outside of Class Hours. 

Some assignments 
require critical thinking 

Select if applicable. 

Reading (required) 

Writing (required) 

Other (optional) 

Provide assignments that align with Objectives, 
demonstrate rigor, intensity, critical thinking, and 
independent study. Include diverse UDL 
submission methods and associated evaluation 
criteria. Writing tips and example phrasing. 

Methods of 
Instruction 

After each selection, describe how it will support the course in terms of 
critical thinking, rigor, difficulty, level, intensity and reflect UDL and 
DEIAA. Select Emergency Remote Instruction. Only courses with 
special circumstances such as CTE are excluded from this. 

Distance Education Section 

1. Distance Education? Select "Yes" to open required fields. 

2. DE Course Cap: Enter the recommended enrollment (Typically 45; verify with Dept. 

Chair). 

3. Formats: Select at least two (e.g., FO, PO, OPA). If choosing only one, provide an 

explanation in the text box. (e.g., All exams or all labs must be in person only). 

4. Part 2 (RSI) and Part 3 (Accessibility): These are auto-embedded; no action is 

needed unless specific discipline requirements require selecting "Other" and explaining. 

No action for General Education/Transfer and Course Articulation sections since they are 
not completed by the COR originator.  

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  
 

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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B.4 CurriQunet Guide - Honors Course Modification Proposal 

Start Here: Use Active COR. Select Modify > Modify Course – Honors and click Create. 

CurriQunet Form Sections  
Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Cover 

Base Course Selection 
Select the Active Base Course in the drop-
down menu. 

1st Semester to be 
offered 

Select a semester fall or spring and year. 

Recommended Course 
Enrollment 

Course Caps: Check with agreed course cap 
between Office of Instruction and AS. 

Catalog Description • Check for “This is an Honors Course.”  

Rationale for 
Modification 

State the reason for the proposed change. 
Example: Six-year revision. 

Honors Section 
Justification 

Can be as brief as this, or more detailed. 

• Students often want a [Discipline] class for 
honors credit. 

Does this course 
equate with a course 

taught at SBVC? 

Look at SBVC course outlines to see if it 
equates. 

Content 
Add Honors Specific Content such as: 

• Original Research in the Field of [Discipline] 
• Effectively present on a research project using appropriate media. 

Objectives 

Add Honors Specific Objective(s) using higher level Bloom’s Taxonomy.  

• Click +Add, select Objective then toggle to open the text box to type 
in objective. Select Requires Critical Thinking if it applies.  

Requisites 
Prerequisite: Acceptance into the College Honors Institute must be in 
Conditions of Enrollment Catalog View. If missing Click +Add > New Non-
Course Requirement: Toggle to open text box then type it in.  

Course Materials Verify that materials from base course copied over correctly. 

Typical Out-of-
Class 

Assignments 

Select Some assignments require critical thinking. Add Honors 
Assignment(s) that demonstrate rigor, intensity, and critical thinking. 
Include diverse UDL submission methods and associated evaluation 
criteria. Writing tips and example phrasing. 

Critical Thinking 
Skills 

Type in the Augmented Critical Thinking skills the honors student will 
develop. As an example, start with: As a result of completing the 
honors course, students will be able to… 

Enhanced 
Instructional 
Methodology 

Describe (in bullets) the ways to enhance assignments, evaluation 
methods, and textbooks and other instructional materials to support the 
honors level of this class. 

DE Check with Honors Coordinator to see if it can be offered as DE. 

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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B.5 CurriQunet Guide - DE only Addendum Proposal 

Start Here: Use Active COR. Select Modify, choose DE Addition Only and click Create. 

Completing a DE Addendum does not change the rest of the Course Outline of Record (COR) 
and does not restart the six-year review cycle. If any other sections require updates, a Course 
Modification (which includes a DE Addendum) is needed. 

CurriQunet Form Sections Changes and Additions 

Cover Page 
The only editable field is Recommended Course Enrollment. All other 
sections are locked and must not be changed. 

Go to the Distance Education section and follow the guidance below 

Distance Education Section 

1. Distance Education? Select "Yes" to open required fields. 

2. DE Course Cap: Enter the recommended enrollment (Typically 45; verify with Dept. 

Chair). 

3. Formats: Select at least two (e.g., FO, PO, OPA). If choosing only one, provide an 

explanation in the text box. (e.g., All exams or all labs must be in person only). 

4. Part 2 (RSI) and Part 3 (Accessibility): These are auto-embedded; no action is 

needed unless specific discipline requirements require selecting "Other" and explaining. 

No action for General Education/Transfer and Course Articulation sections since they are 
not completed by the COR originator.  

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  
 

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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B.6 CurriQunet Guide - New Program Proposal 

Start Here: Initiate by clicking the Create New Proposal, select Program, and click Create 

CurriQunet Form Sections 
Program Narrative: The following areas make up the Program Narrative. 
Consists of the program description, program goals and objectives, justification for the program, 
labor market or transfer information when applicable, and program learning outcomes.   

Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Basic Program 
Information 

Program Information Complete all Fields 

Career and Academic 
Pathways 

This list must have at least 1 item and up to 3. 

Program Goal/Purpose Select one: Transfer, CTE, or Local.  

Proposal Information Complete all fields 

Feasibility 

Role of Programs Relationship to the Mission of the College. 

Role of Place of Program in Curriculum/similar Programs at College. 

List Similar Programs at other Colleges in Service Area, if any. 

Description 

Catalog Description: Provide a concise overview of the program's 
purpose, target audience, and the core knowledge or career/transfer 
pathways students will be prepared for upon completion. 

Program Goals and Objectives: Define the specific educational 
milestones, workforce competencies, or transfer requirements the 
program is designed to fulfill.  

Program 
Requirements 

Course or Non-Course 
Requirement 

Select the required courses that supports the 
Program Learning Outcomes. 

Group (Courses) 

Use for “AND”, “OR”, “Required” 
Select a course then drag the course about an 
inch to the right until it indents, add the next 
course and do the same. 

Program Learning 
Outcomes 

Student Learning 
Outcomes (SLOs) from 

required courses 

Click +Add, select Outcome then toggle to 
open. Fill in Outcome Text. Each Outcome will 
be a separate entry. 

Institutional Learning 
Outcomes (ILOs) 

Select appropriate area(s) more than one may 
be selected. 

General Education 
Outcomes (GEOs) 

Select appropriate area(s) more than one may 
be selected. 

Noncredit 
Documentation 

Select if this Award is noncredit. Then select CDCP Eligibility Category. 

Proposed 
Sequence 

BEFORE LAUNCHING: Send the Proposed Sequence directly to the 
Curriculum Chair(s) via email, as the Chair is the only one who can enter 
this. Failure to complete this will delay the approval process. 

CTE Courses 
Complete the CTE Documentation section and related attachments. 
Career Technical Education (CTE) & Regional Planning Links 

Review and Launch: Need Help? If you are unsure about any section, contact the 
Curriculum Chair(s) before launching the proposal.  
Required Action to View Proposal History: Originators are responsible to review the 
comments and suggestions for edits throughout the Review/Approval process. There will be 
opportunities to edit the Proposal before final approval based on these comments. Failure to do 
this will delay the approval progress. 

https://www.craftonhills.edu/about-chc/mission.php
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B.7 CurriQunet Guide - Program Modification 

Start Here: Find the Active Program > Select Modify > Program Modification > Create 

CurriQunet Form Sections The following areas make up the Program Narrative 
Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Basic Program 
Information 

Program Information Verify still accurate, make changes if necessary 

Career and Academic 
Pathways 

This list must have at least 1 item and up to 3. 

Program Goal/Purpose Select one: Transfer, CTE, or Local.  

Proposal Information 

Indicate what percentage of the program is 
approved to offer through Distance Education. 

Complete: Rationale for Program Modification. 

Complete: Transfer Preparation Information. 

Co-Contributors Only those in the same discipline can be a co-contributor. 

Feasibility 

Describe the Programs relationship to the Mission of the College. 

Describe the place of Program in curriculum/similar programs at college. 

List similar programs at other colleges in service area. 

Description 

Catalog Description: Provide a concise overview of the program's 
purpose, target audience, and the core knowledge or career/transfer 
pathways students will be prepared for upon completion. 

Program Goals and Objectives: Define the specific educational 
milestones, workforce competencies, or transfer requirements the 
program is designed to fulfill. 

Program 
Requirements 

Course or Non-Course 
Requirement 

Select courses. “Include in SLO map” must be 
selected to have it populate the Program 
Learning Outcomes. 

Group (Courses) 

Use for “AND”, “OR”, “Required”  
Select a course then drag the course about an inch 
to the right until it indents, add the next course and 
do the same. 

Program Learning 
Outcomes 

Click +Add button, 
select Outcome 
then toggle to open 
the fields. Each 
Outcome will be a 
separate entry. 

Select one Outcome from Course(s) in the 
Program that Meet this Outcome. Copy and 
paste it into the Outcome* textbox  

Check all that apply: This program aligns to the 
following Institutional Outcomes. 

Check all that apply: This program aligns to the 
following General Education Outcomes.  

Noncredit 
Documentation 

Select if this Award is noncredit. Then select CDCP Eligibility Category. 

Proposed 
Sequence 

BEFORE LAUNCHING: Send the Proposed Sequence directly to the 
Curriculum Chair(s) via email, as the Chair is the only one who can enter 
this. Failure to complete this will delay the approval process. 

CTE Courses 
Complete the CTE Documentation section and related attachments. 
Career Technical Education (CTE) & Regional Planning Links 

Review and Launch: Need Help? If you are unsure about any section, contact your 
Curriculum Chair(s) before launching the proposal. Required Action to View Proposal 
History: Originators are responsible to review the comments and suggestions for edits 
throughout the Review/Approval process. There will be opportunities to edit the Proposal before 
final approval based on these comments. Failure to do this will delay the approval progress. 

https://www.craftonhills.edu/about-chc/mission.php
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Part 1.C.1. How to Complete a Common Course Number (CCN) Course 

Modification 

Start Here: Find Active COR. Select Modify, choose Course Modification and click Create. 

Common Course 
Numbering (CCN) 

Go to: Course Outline of Records (COR) Common Course Numbering 
Templates. Many sections are labeled Required and/or Identical, and it 
must be entered IDENTICAL to the template. Some areas allow for 
optional entries. Label these as shown as Part 1, and Part 2, etc… 

CurriQunet Form Sections 

Title 5 Lexicon: A quick reference for integrating required Title 5 terminology into course outlines. 

Cover 

Course Discipline, 
Number and Title 

Only the Curriculum Chair(s) can change these, 
the originator cannot. Ask Chair if needed. 

Short Title 
Can be same or different from title  
Example: Organic Chemistry → OCHEM 

1st Semester to be 
offered 

Select a semester fall or spring and a year. 

Recommended 
Course Enrollment 

Course Caps: Check with agreed course cap 
between Office of Instruction and AS, do not 
just change them. 

Standalone course Select if this is a standalone course. 

Catalog Description • Check CCN (follow exactly). 

Schedule Description Will be the same as the Catalog Description. 

Need for the Course 

• Justify why the college should offer the course; 
fulfills program, degree, certificate, or transfer 
requirements.  

• Check that course numbers are accurate and 
revise if needed.  

• Update all IGETC references to CalGETC 

Goals for the Course 

Describe how the course supports the college 
mission by promoting academic excellence, 
critical thinking, lifelong learning, and transfer or 
career readiness. 

Rationale for course 
modifications 

State the reason for the proposed change:  
CCN update 

Does this course 
equate with a course 

taught at SBVC? 

Look at SBVC course outlines to see if it 
equates. 

Co-Contributors Only those in the same discipline can be a co-contributor. 

Cross Listed 
Course 

Reminder: Include both in Catalog Description. No other action. 
Curriculum Chair(s) will populate this section in CurriQunet. 

Units and Hours • Check CCN (follow exactly). 

Course Standards 
Grading Method: Select Pass/No Pass or Letter Grade. 
Scroll down to verify or select any areas that apply. 

https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/course-outline-of-records-submission#:~:text=Common%20Course%20Numbering%20Templates,of%20evaluations%20and%20representative%20texts.
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/course-outline-of-records-submission#:~:text=Common%20Course%20Numbering%20Templates,of%20evaluations%20and%20representative%20texts.
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Content 

• Check CCN (follow exactly). 

• Be sure to use CurriQunet Outlining Tool only to ensure proper 
format in COR. Do not paste in a Word “outlined format”, it will appear 
wrong in the COR PDF. 

Objectives 

• Check CCN (follow exactly).  

• Click +Add button, select Objective then toggle to open the text box to 
type in objective. Select “Requires Critical Thinking” if it applies. 
Each Objective will be a separate entry. 

Entrance Skills 
• Check to verify if it is still appropriate.  

• Click +Add, select Entrance Skill then select Entrance Skill type. Each 
Entrance Skill will be a separate entry. 

Student Learning 
Outcomes (SLOs) 

Student Learning 
Outcomes (SLOs) 

• These are determined by the discipline. Use 

higher level Bloom’s Taxonomy 

• Click +Add, select Outcome then toggle to 
open. Fill in Outcome Text. Each Outcome 
will be a separate entry. 

General Education 
Outcomes (GEOs) 

Select appropriate area(s) more than one may 
be selected. 

Institutional Learning 
Outcomes (ILOs) 

Select appropriate area(s) more than one may 
be selected. 

Requisites 

Be sure to check that Requisite Courses have not changed number or 
discipline code since last COR. 

• Prerequisite 

• Corequisite 

• Departmental 
Recommendations 

• Limitation on 
Enrollment  

• Check CCN (follow exactly) 

• For Honors courses, add Prerequisite: 
Acceptance into the College Honors Institute 
Click +Add > New Non-Course Requirement: 
Toggle to open text box then type: 
“Prerequisite: Acceptance into the College 
Honors Institute” 

Requisite 
Validation 

Legacy Entrance 
Skills 

Manually re-enter any valid legacy data, as it 
does not transfer to the outline. 

See message in CurriQunet if you have any issues with this section 

• Click +Add, select New Requisite Type then toggle to open. Select 
Requisite Course then Content Review Type.  
o Content to Content: Fill in both text boxes.  

o Entrance Skills to Objectives: Select all that apply. 

o Entrance Skills to Entrance Skills: Select all that apply 

Methods of 
Evaluation 

• Check CCN (follow exactly). 

Click +Add, select New Evaluation Method, then toggle to open. Select 
Evaluation Method from the drop-down menu. Percents are optional, but 
if given ensure they add up to 100%. Each Evaluation Method will be a 
separate entry. 

• Be sure to check that Requisite Courses have not changed number 
or discipline code since last COR. 

• Methods of Evaluation (legacy): Manually re-enter any valid legacy 
data, as it does not transfer to the outline. 
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UDL and DEIAA 

Components will be automatically embedded into COR. Select Credit by 
Exam if applicable. Components will be automatically embedded into 
COR. Select Credit by Exam or Credit by Prior Learning if applicable. 
Use textbox for any additional UDL and DEIAA opportunities for this 
course. 

Course Materials 

• Check CCN (follow exactly) List all of them. 

• Textbook: Click +Add, select Textbook, then toggle to open and 
complete all fields including “Show how course materials reflect 
equity”. Each Textbook will be a separate entry. 

• Follow the same procedure for adding Manual, Software, and Other 
Learning Materials. 

Typical Out-of-
Class Assignments 

Hours per week on 
assignments outside 

of the class 

See the provided chart for reference on the 
number of hours to enter.  

3-unit lecture = 6-Outside of Class Hours. 

Some assignments 
require critical 

thinking 
Select if applicable. 

Reading (required) 

Writing (required) 

Other (optional) 

Provide assignments that align with Objectives, 
demonstrate rigor, intensity, critical thinking, and 
independent study. Include diverse UDL 
submission methods and associated evaluation 
criteria. Writing tips and example phrasing. 

Methods of 
Instruction 

After each selection, describe how it will support the course in terms of 
critical thinking, rigor, difficulty, level, intensity and reflect UDL and 
DEIAA. Select Emergency Remote Instruction. Only courses with 
special circumstances such as CTE are excluded from this. 

Distance Education Section 

1. Distance Education? Select "Yes" to open required fields. 

2. DE Course Cap: Enter the recommended enrollment (Typically45; verify with Dept. 
Chair). 

3. Formats: Select at least two (e.g., FO, PO, OPA). If choosing only one, provide an 
explanation in the text box. (e.g., All exams or all labs must be in person only). 

4. Part 2 (RSI) and Part 3 (Accessibility): These are auto-embedded; no action is 
needed unless specific discipline requirements require selecting "Other" and explaining. 

No action for General Education/Transfer and Course Articulation sections since they are 
not completed by the COR originator.  

Need Help? If you are unsure about any section, contact the Curriculum Chair(s) before 
launching the proposal. 

Review COR for accuracy (Reports  > PDF). After select Launch  to start 
the approval process.  
 

Required Action to View Proposal History : Originators are 
responsible to review the comments and suggestions for edits throughout the Review/Approval 
process. There will be opportunities to edit the COR before final approval based on these 
comments. Failure to do this will delay the approval progress. 
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Part 2: Curriculum Committee Members COR and Program 

Technical Review Guides 

Part 2.A. Committee Member Responsibilities 

• Complete Technical Reviews Timely: Finish all reviews before the meeting. 

• Use Comments: Communicate suggested edits, revisions, compliance issues, or 
missing sections via the Comments section in CurriQunet. Be clear, specific, and 
focused on required elements. Reviewers provide feedback as a Technical Review; 
however, discipline faculty retain final authority over phrasing to ensure course-specific 
accuracy. 

• Committee Role: 

o Verify proposals are complete, logically aligned, and compliant with Title 5 and 
District standards. 

o Reviewers provide feedback on technical compliance and clarity; however, 
disciplinary faculty retain primary responsibility and final say for course content 
and objectives.  

• Focus Areas / Commonly Missed Items: 

o Objectives missing “Requires Critical Thinking”.  

o Textbooks missing “Show how course materials reflect equity”. 

o Requisites validation. 

o Honors augmented sections not completed. 

• C-ID Courses: Ensure descriptor language is reflected for state approval. 

• Goal: Confirm proposals are coherent, complete, and ready for next-level approval while 
respecting disciplinary expertise. 

• State-Approved COR Sections: Course ID/Title, Catalog Description, Units, 
Requisites, Corequisites, Dept. Recommendations, Content, Objectives, 
Instruction/Evaluation Methods, Textbooks, and Assignments (Reading/Writing). Local 
(SBCCD/CHC) Sections: Rest of COR including :SLOs, Need for Course, and Course 
Goals. 

Part 2.B. CurriQunet: How to Use and Navigate 

• Log into CurriQunet using your campus credentials.  

• Start at Curriculum . Click Approvals , select the 
proposal requiring your action, review the History tab to avoid repeating comments, 

then click View Proposal.  

• From the Approvals use the drop-down menu for Action to select Reviewed from the 

dropdown menu.  

• Enter all substantive feedback and suggested revisions in the Comments section 
Provide clear, specific comments to guide the Originator’s revisions prior to final 

approval. and select Commit to save your review.  

• Tip: Evaluate the official COR by viewing the Report PDF. 
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Part 2.C. Content Reviewer Guides and Technical Review Checklists 

C.1. New Course COR Technical Review Checklist 

Course Reviewed: ___________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

C-ID 
Descriptors 

Check to see if 
there is a C-ID 
Descriptor.  

 

CHC Catalog will show C-ID 
number for reference. Not all 
courses have a C-ID. 
Go to C-ID Descriptors – Final 
for requirements. 

 

Cover 

Course Number Verify New Course Number  

Start Semester Verify Completed.  

Enrollment Cap Verify Completed.  

Catalog Description 

For cross-listed courses, both 
disciplines must be listed in the 
Description (e.g. This course is 
offered as ETHS 141 and SOC 
141). 

 

Schedule 
Description 

Ensure it is identical to the 
Catalog Description. 

 

Need for the 
Course 

Verify Completed. 
 

Goals for Course Verify Completed.  

Units and 
Hours 

 Verify Completed. 
 

Content  
Look at Report PDF to check 
Outline format used CurriQunet 
Outlining Tool. 

 

Objectives 
Must be linked to 

Content  

Check if linked to content using 
higher level Bloom’s Taxonomy 
and "Requires Critical 
Thinking" is ON where 
applicable. 

 

http://www.c-id.net/descriptors/final
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CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Student 
Learning 

Outcomes 
(SLOs) 

Student Learning 
Outcomes (SLOs) 

These are determined by the 
discipline. Verify outcomes linked 
to content. Check for high level 
Bloom’s Taxonomy. 

 

 (GEOs) and 
(ILOs) 

Verify Outcomes selected.  

Requisites Prerequisites If applicable  

Requisite 
Validation 

 
If applicable-verify validation was 
made. 

 

Methods of 
Evaluation 

 
Percent optional. Verify if % 
given they add to 100%.  

 

UDL and 
DEIAA 

 Embedded- No need to verify. 
 

Course 
Materials 

Textbooks 

Verify all fields completed 
including “Show how course 
materials reflect equity”. 

OER texts are clearly identified. 

 

Typical Out-
of-Class 

Assignments 

Outside of Class 
Hours 

Verify unit and hours given. 
 

Reading (Required) 
Writing (Required) 

Other 

Verify: Aligns with Objective, has 
multiple means of demonstrating 
learning and evaluation method 
given.  

Verify: Some assignments 
require critical thinking 
selected. 

 

Methods of 
Instruction 

Instruction 
Methods 

Verify description given on each 
Instruction Method. 

 

Emergency 
Remote 

Instruction 

Verify selected. Only courses 
with special circumstances such 
as CTE are excluded from this. 

 

DE 

Enrollment Cap Verify Completed. 
 

Part 1: DE Format 

Verify selection of at least two 
DE formats appropriate for this 
course: FO, PO, OPA 

 

If only one DE format is chosen, 
explained why (e.g., lecture 
online but lab must be in-
person). 

 

Part 2: Regular 
and Substantive 
Interaction (RSI) 

If Other selected verify 
Explanation was given. 
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C.2. Honors Course COR (New and Modifications) Technical Review Checklist 

Course Reviewed: ___________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Cover 

Course 
Number/Title 

Verify "H" and "Honors" added. 
 

Start Semester Verify Completed.  

Enrollment Cap Verify Completed.  

Catalog Description 
Verify addition: "This is an Honors 
course.” 

 

Schedule 
Description 

Ensure it is identical to the 
Catalog Description. 

 

Justification 
Confirm reasoning (e.g., "Students 
often want a [Discipline] class for 
honors credit."). 

 

Content Honors Specifics 

Look for Honors specific 
Content (e.g., Original Research 
in the Field of [Discipline], 
Regular meetings with instructor 
regarding honors work.) 

 

Objectives New Objectives 

Check for Honors specific 
Objectives linked to content 
using higher level Bloom’s 
Taxonomy, and that "Requires 
Critical Thinking" is ON. 

 

Requisites Prerequisites 
Confirm text: "Prerequisite: 
Acceptance into the College 
Honors Institute"  in Catalog View. 

 

Typical Out-
of-Class 

Assignments 

Honors Work 
Honors-specific 

assignments 

Verify: Aligns with Objective, has 
multiple means of demonstrating 
learning and evaluation method 
given.  
Verify: Some assignments 
require critical thinking selected. 

 

Critical 
Thinking 

Augmented Skills 

Confirm it begins with: "As a 
result of completing the honors 
course, students will be able 
to..." 

 

Methodology 
Enhanced 

Instructional 
 

Check for bulleted descriptions 
of enhanced assignments, 
evaluations, and 
textbooks/materials. 
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C.3. Course Modification COR Technical Review Checklist (Includes 6-yr 

Revisions) 

Course Reviewed: ___________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

C-ID 
Descriptors 

Check to see if 
there is a C-ID 
Descriptor.  

 

CHC Catalog will show C-ID 
number for reference. Not all 
courses have a C-ID. 
Go to C-ID Descriptors – Final 
for requirements. 

 

Cover 

Start Semester Verify Completed.  

Enrollment Cap Verify Completed.  

Catalog Description 

For cross-listed courses, both 
disciplines must be listed in the 
Description (e.g. This course is 
offered as ETHS 141 and SOC 141). 

 

Schedule 
Description 

Ensure it is identical to the 
Catalog Description. 

 

Need for the 
Course 

Verify Completed and CalGETC 
references (not IGETC) 

 

Goals for Course Verify Completed.  

Rationale for 
Modification 

Verify Completed. 
 

Units and 
Hours 

 Verify Completed. 
 

Content  
Look at Report PDF to check 
Outline format used CurriQunet 
Outlining Tool.. 

 

Objectives 
Must be linked to 

Content  

Check if linked to content using 
higher level Bloom’s Taxonomy 
and "Requires Critical 
Thinking" is ON where 
applicable. 

 

Student 
Learning 

Outcomes 
(SLOs) 

Student Learning 
Outcomes (SLOs) 

Verify Outcomes given. These 
are determined by the discipline. 
Check for high level Bloom’s 
Taxonomy. 

 

http://www.c-id.net/descriptors/final
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CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

 (GEOs) and 
(ILOs) 

Verify Outcomes selected.  

Requisites Prerequisites 

If applicable. Check that 
Requisite Courses have not 
changed number or discipline 
code since last COR. 

 

Requisite 
Validation 

 
If applicable-verify validation was 
made. 

 

Methods of 
Evaluation 

 
Percent optional. Verify if % 
given they add to 100%. 

 

UDL and 
DEIAA 

 Embedded- No need to verify. 
 

Course 
Materials 

Textbooks 

Verify all fields completed 
including “Show how course 
materials reflect equity”. 

OER texts are clearly identified. 

 

Typical Out-
of-Class 

Assignments 

Outside of Class 
Hours 

Verify unit and hours given. 
 

Reading (Required) 
Writing (Required) 

Other 

Verify: Aligns with Objective, has 
multiple means of demonstrating 
learning and evaluation method 
given.  

Verify: Some assignments 
require critical thinking 
selected. 

 

Methods of 
Instruction 

Instruction 
Methods 

Verify description given on each 
Instruction Method. 

 

Emergency 
Remote 

Instruction 

Verify selected. Only courses 
with special circumstances such 
as CTE are excluded from this. 

 

DE 

Enrollment Cap Verify Completed  

Part 1: DE Format 

Verify selection of at least two 
DE formats appropriate for this 
course: FO, PO, OPA 

 

If only one DE format is chosen, 
explained why (e.g., lecture 
online but lab must be in-
person). 

 

Part 2: Regular 
and Substantive 
Interaction (RSI) 

If Other selected verify 
Explanation was given. 
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C.4. DE Only Addendum COR Technical Review Checklist 

Course Reviewed: ___________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Cover Enrollment Cap Verify Completed.  

Distance 
Education  

Part 1: DE Format 

Verify selection of at least two 
DE formats appropriate for this 
course: FO, PO, OPA 

 

If only one DE format is chosen, 
explained why (e.g., lecture 
online but lab must be in-
person). 

 

Part 2: Regular 
and Substantive 
Interaction (RSI) 

If Other selected verify 
Explanation was given. 
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C.5. Program Proposal (New and Modifications) Technical Review Checklist 

Program Reviewed: __________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Basic Program 
Information 

Program 
Information 

Verify Completed. 
 

Career and 
Academic 
Pathways 

Verify list has at least 1 item 
and up to 3. 

 

Program 
Goal/Purpose 

Verify selected one: Transfer, 
CTE, or Local. 

 

Proposal 
Information 

Verify Completed.  

Feasibility 

Verify Role of Programs Relationship to the Mission 
of the College completed. 

 

Verify Place of Program in Curriculum/Similar 
Programs at College completed. 

 

Verify Similar Programs at Other Colleges in Service 
Area listed if any. 

 

Description 
Verify Catalog Description completed.  

Verify Program Goals and Objectives completed.  

Program 
Requirements 

Verify Program Requirements completed.  

Program 
Learning 

Outcomes 

Verify Completed.  

Verify Completed.  

Verify Completed.  

Noncredit 
Documentation 

Verify completed if applicable. 
 

Proposed 
Sequence 

Verify Completed.  
 

CTE Courses 
Verify Completed: CTE Documentation section and 
related attachments. Career Technical Education 
(CTE) & Regional Planning Links 

 

 

  

https://www.craftonhills.edu/about-chc/mission.php
https://www.craftonhills.edu/about-chc/mission.php
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C.6. CCN Modification COR Technical Review Checklist 

Course Reviewed: ___________________________________________________________ 

• Start at Curriculum. Click Approvals, select the proposal requiring your action, review 

the History tab to avoid repeating comments, then click View Proposal. 

• From the Approvals page, select Reviewed from the dropdown menu. 

• Enter all substantive feedback and suggested revisions in the Comments section and 

select Commit to save your review. Provide clear, specific comments to guide the 

Originator’s revisions prior to final approval. 

CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Common 
Course 

Numbering 
(CCN) 

Go to: Course Outline of Records (COR) Common Course Numbering 
Templates. Many sections are labeled Required and/or Identical, and it 
must be entered IDENTICAL to the template. Some areas allow for optional 
entries. 

Cover 

Start Semester Verify Completed.  

Enrollment Cap Verify Completed.  

Catalog Description 

For cross-listed courses, both 
disciplines must be listed in the 
Description (e.g. This course is 
offered as ETHS 141 and SOC 
141). 

 

Schedule 
Description 

Ensure it is identical to the 
Catalog Description. 

 

Need for the 
Course 

Verify Completed and CalGETC 
references (not IGETC) 

 

Goals for Course Verify Completed.  

Rationale for 
Modification 

Verify Completed. 
 

Units and 
Hours 

 Verify Completed. 
 

Content  
Look at Report PDF to check 
Outline format used CurriQunet 
Outlining Tool.. 

 

Objectives  

Check for high level Bloom’s 
Taxonomy and "Requires 
Critical Thinking" is ON where 
applicable. 

 

Student 
Learning 

Outcomes 
(SLOs) 

Student Learning 
Outcomes (SLOs) 

Verify Outcomes given. These 
are determined by the discipline. 
Check for high level Bloom’s 
Taxonomy.  

 

(GEOs) and (ILOs) Verify Outcomes selected.  

https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/course-outline-of-records-submission#:~:text=Common%20Course%20Numbering%20Templates,of%20evaluations%20and%20representative%20texts.
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/course-outline-of-records-submission#:~:text=Common%20Course%20Numbering%20Templates,of%20evaluations%20and%20representative%20texts.
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CurriQunet 
Section 

Field / 
Requirement 

Committee Member Action & 
Verification 

Notes/Comments 

Requisites Prerequisites 

If applicable. Check that 
Requisite Courses have not 
changed number or discipline 
code since last COR. 

 

Requisite 
Validation 

 
If applicable-verify validation was 
made. 

 

Methods of 
Evaluation 

 
Percent optional. Verify if % 
given they add to 100%. 

 

UDL and 
DEIAA 

 Embedded- No need to verify. 
 

Course 
Materials 

Textbooks 

Verify all fields completed 
including “Show how course 
materials reflect equity”. 

OER texts are clearly identified. 

 

Typical Out-
of-Class 

Assignments 

Outside of Class 
Hours 

Verify unit and hours given. 
 

Reading (Required) 
Writing (Required) 

Other 

Verify: Aligns with Objective, has 
multiple means of demonstrating 
learning and evaluation method 
given.  

Verify: Some assignments 
require critical thinking 
selected. 

 

Methods of 
Instruction 

Instruction 
Methods 

Verify description given on each 
Instruction Method. 

 

Emergency 
Remote 

Instruction 

Verify selected. Only courses 
with special circumstances such 
as CTE are excluded from this. 

 

DE 

Enrollment Cap Verify Completed  

Part 1: DE Format 

Verify selection of at least two 
DE formats appropriate for this 
course: FO, PO, OPA 

 

If only one DE format is chosen, 
explained why (e.g., lecture 
online but lab must be in-
person). 

 

Part 2: Regular 
and Substantive 
Interaction (RSI) 

If Other selected verify 
Explanation was given. 
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Part 3: Curriculum Toolkit 

Part 3.A. Resources, Regulations, and Glossary 

I. Local & Primary Resource Links 

These tools are your first stop for local CHC processes and general curriculum guidelines. 

• CHC Curriculum Home Page: The central hub for Crafton Hills College curriculum cycles and local 

committee information. 

• CurriQunet General User Guide - Meta: Technical guidance for navigating the CurriQunet Meta 

platform used for course and program submissions. 

• CourseAlign.ai: An AI-powered tool for educators to design and revise aligned, student-centered 

courses with real-time curriculum checks. 

• CCCCO Program and Course Approval Handbook (PCAH): The definitive 8th Edition guide from 

the Chancellor's Office for all credit and noncredit standards. 

II. Regulatory & Legal Mandates 

Official California codes and numbering systems that govern community college education. 

• Title 5: Curriculum and Instruction: The complete legal text of the California Code of Regulations 

governing Division 6 (Community Colleges). 

• C-ID (Course Identification Numbering System): Verification site for course-to-course articulation 

descriptors required for Associate Degrees for Transfer (ADTs). 

• Chancellor’s Office Curriculum Inventory (COCI): The state-level database where all programs and 

courses are officially chaptered and issued control numbers.  

• Cal-GETC Standards 

• The UCOP page on special regulations for courses in specific subject 

• ASSIST Articulation System: The official repository for California’s transfer and articulation data 

between community colleges and universities. 

III. Equity & Instructional Design 

Tools to ensure curriculum meets new accessibility and equity-minded standards. 

• CAST UDL Guidelines: Concrete suggestions rooted in the principles of Universal Design for 

Learning (UDL) to provide multiple means of engagement and representation. 

• California LaunchBoard: A data dashboard used to track equitable student outcomes, including wage 

gains and job placement. 

• The COR Checker is a specialized tool designed by Innovating Higher Ed to help curriculum 

committees and faculty evaluate the quality and compliance of a COR 

IV. Career Technical Education (CTE) & Regional Planning 

Specific resources for labor market verification and regional consortium approval, particularly for the Los 

Angeles and Inland Empire regions. 

• LARC Program Recommendation Process: Step-by-step instructions for securing regional approval 

for CTE programs. 

• LARC Business Meeting Archives: Access to meeting minutes required to prove regional 

recommendation for new programs. 

• Centers of Excellence (COE) for Labor Market Research: The primary source for requesting the 

LMI data reports required for all new CTE programs. 

• Strong Workforce Program (SWP): State initiative details for aligning programs with regional 

economic mobility goals. 

• COE TOP-CIP-SOC Crosswalk Dashboard: A critical tool for mapping educational TOP codes to 

federal occupational codes for LMI analysis.  

• California LaunchBoard: The data tool used to verify student outcomes for Strong Workforce 

alignment. 

https://www.craftonhills.edu/faculty-and-staff/curriculum/index.php
https://www.craftonhills.edu/faculty-and-staff/curriculum/documents/curriqunet-meta-general-user-guide-11-09-21.pdf
https://coursealign.ai/
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://shared-govt.westlaw.com/calregs/Browse/Home/California/CaliforniaCodeofRegulations?transitionType=Default&contextData=%28sc.Default%29
https://c-idsystem.org/courses/
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/What-we-do/Curriculum-and-Instruction-Unit
https://icas-ca.org/wp-content/uploads/2025/06/Cal-GETC_Standards_1v3_-Final_r-2.pdf
https://www.ucop.edu/transfer-articulation/transfer-course-agreements/tca-policy/regulations-by-subject-area.html
https://assist.org/
https://udlguidelines.cast.org/
https://www.calpassplus.org/LaunchBoard/Home.aspx
https://innovatinghighered.com/cor-checker.html
https://losangelesrc.org/program-recommendation/
https://losangelesrc.org/meeting-archives/
https://coeccc.net/
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Workforce-and-Economic-Development/Strong-Workforce-Program
https://www.google.com/search?q=https://coeccc.net/resources/top-cip-soc-crosswalk/
https://www.calpassplus.org/LaunchBoard/Home.aspx
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Workforce-and-Economic-Development/Strong-Workforce-Program
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V. Glossary of General Terms 

• AD-T (Associate Degree for Transfer): A specific type of associate degree (AA-T/AS-T) 
designed for streamlined transfer to the CSU system. 

• CalGETC (California General Education Transfer Curriculum): The new singular GE 
pattern required for transfer to CSU or UC systems. 

• CB Codes (Course Basic): Data elements used to track course characteristics (e.g., CB03 
for TOP Code). 

• CCN (Common Course Numbering): A state initiative to establish common numbering 
across the system to ease student transfer. 

• CDCP (Career Development and College Preparation): Noncredit courses eligible for 
enhanced funding in categories like ESL or Short-term Vocational. 

• C-ID (Course Identification Numbering System): A system used to ensure course 
equivalency across California colleges. 

• CLNA (Comprehensive Local Needs Assessment): A biennial review required by Perkins 
V to identify regional workforce gaps. 

• COCI (Chancellor’s Office Curriculum Inventory): The state database where all approved 
programs are "chaptered." 

• COR (Course Outline of Record): The legal document defining the content and standards 
for a course. 

• CTE (Career Technical Education): Programs designed to provide students with technical 
skills for high-wage careers. 

• DEIAA (Diversity, Equity, Inclusion, Accessibility, and Anti-Racism): A framework 
ensuring curriculum is inclusive and addresses the needs of all students. 

• FO (Fully Online): A distance education modality where 100% of instruction occurs online. 
• GEO / ILO / PLO / SLO: Nested layers of outcomes (General Education, Institutional, 

Program, and Student Learning) used to measure achievement. 
• LMI (Labor Market Information): Data regarding job growth used to justify the need for CTE 

programs. 
• OER (Open Educational Resources): Free teaching and learning materials that permit 

repurposing. 
• OPA (Online with In-Person Proctored Assessments): "Hybrid" modality combining in-

person and online instruction with in-person proctored assessments.  
• Originator: The faculty author who initiates and submits the COR for review. 
• PO (Partially Online): A "Hybrid" modality combining in-person and online instruction. 
• RSI: (Regular and Substantive Interaction): Instructor-initiated communication such as 

announcements, personalized feedback, guided discussions, and synchronous instruction, 
that is frequent, consistent, and academic in nature. 

• UDL (Universal Design for Learning): An educational framework guiding the development 
of flexible learning environments. 

VI. Certificate Naming Conventions & Acronyms 

• CofA (Certificate of Achievement): A credit certificate (8+ units) chaptered by the 
State that appears on the official transcript. 

• Local Certificate: A certificate requiring fewer than 16 units that has not been 
chaptered; it does not appear on the transcript. 

• Certificate of Completion (Noncredit): An award leading to improved employability or 
job opportunities. 

• Certificate of Competency (Noncredit): An award for students in ESL or Basic Skills 
preparing for credit-level work. 

• SCV (Short-term Vocational): A category of noncredit CTE courses supported by LMI. 

https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/About-Us/Chancellors-Office/Divisions/Educational-Services-and-Support/burden-free-instructional-materials/open-educational-resources
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://udlguidelines.cast.org/
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
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VII. Title 5 Lexicon 

Academic Rigor & Evaluation 

• Critical Thinking: Analysis, synthesis, and evaluation of information. 

• Independent Study: Student work performed outside of scheduled instructional hours. 

• Proficiency: The measurable level of mastery required to pass the course. 

• Scope and Intensity: The depth of subject matter and the workload expected of the student. 

• College Level: Evidence that vocabulary and learning skills are appropriate for post-secondary 
education. 

• Demonstrated Mastery: Proof of skill acquisition through specific assessment tools. 

Enrollment & Compliance 

• Prerequisite: A mandatory requirement for enrollment based on safety or a high likelihood of failure 
without it. 

• Corequisite: A course required to be taken simultaneously with another. 

• Advisory: A recommendation for preparation that is not legally mandatory. 

• Content Review: The formal faculty process used to establish and justify prerequisites. 

• Disproportionate Impact: Barriers that negatively affect specific student populations (DEIAA focus). 

• Mission Appropriate: Alignment with the primary goals of the California Community Colleges 
(Transfer, CTE, or Basic Skills). 

Instructional Modality & Interaction 

• Regular and Substantive Interaction (RSI): A federal and state (Title 5) mandate requiring 
instructor-initiated, academic engagement in Distance Education to distinguish it from 
correspondence schooling. Crafton Hills College RSI Guide. 

• Asynchronous: Instruction where the teacher and student do not interact in real-time. 

• Synchronous: Instruction that occurs simultaneously via technology. 

• Accessibility: Ensuring materials meet UDL Guidelines and DEIAA standards. 

• Instructional Activities: The specific methods used to deliver course content. 

Vocational & Competency-Based 

• Employability: The primary objective of a Certificate of Completion. 

• Competencies: Specific, measurable skills achieved (predominantly used in Noncredit/CDCP). 

• Labor Market Demand: Statistical evidence of job availability (LMI). 

• Net Job Market: An analysis showing enough local openings exist for the number of projected 
graduates. 

Quick Swap Reference Table 

Common Phrase Title 5 "Power Word" 

Homework Outside-of-class Hours, Independent Study Hours 

Classes / Lessons Instructional Activities 

Passing the Class Demonstrating Proficiency 

Online Class Distance Education Modality 

Contacting the Teacher Regular and Substantive Interaction 

Career Goal Defined Objective / Program Goal 

https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.craftonhills.edu/faculty-and-staff/online-teaching/de-rsi.php
https://udlguidelines.cast.org/
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://labormarketinfo.edd.ca.gov/
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Part 3.B. Sections in CurriQunet: Definitions and Examples 

These instructions and examples are designed with student success as the primary focus. A 

clear, compliant Course Outline of Record (COR) ensures that courses meet California 

Education Code Title 5 and California Community Colleges Program and Course Approval 

Handbook standards while supporting meaningful, high-quality learning experiences. By 

carefully following these guidelines, authors strengthen the rigor, clarity, and consistency of their 

proposals and help facilitate a smoother review and approval process. 

The guidance and examples also intentionally integrate Universal Design for Learning (UDL) 

and Diversity, Equity, Inclusion, Accessibility, and Anti-Racism (DEIAA) principles to promote 

academic intensity, remove unnecessary barriers, foster inclusive learning environments, and 

advance equitable student outcomes. 

Title 

Course titles should be informative and specific, clearly communicating what the course is 

about. When developing or reviewing a title and in keeping with UDL and DEIAA, consider 

whether a first-generation college student would understand it, whether it accurately reflects the 

actual course content, and whether it avoids abbreviations, jargon, or coded language that could 

create confusion or limit accessibility. 

Catalog/Schedule Description 

• The catalog description must clearly summarize the course purpose, goals, primary 

topics, and body of knowledge; describe what students will learn; and, when appropriate, 

identify the intended audience without assuming prior background. Courses serving 

specific populations must demonstrate how they meet that group’s needs. 

• In accordance with Title 5, § 55002 and the PCAH, the description should reference 

relevant program requirements, prerequisites or enrollment limitations, student learning 

outcomes, and alignment with program goals, as applicable. 

• To align with UDL and DEIAA, descriptions must use clear, inclusive, plain language; 

focus on student learning; state the course purpose; avoid cultural bias; and not imply 

unnecessary barriers to enrollment or success. 

• The Schedule Description (if separate) will match the Catalog Description. 

Catalog Description example phrasing: 

• COMM C1000 – Public Speaking:  In this course, students learn and apply foundational 

rhetorical theories and techniques of public speaking in a multicultural democratic 

society. Students discover, develop and critically analyze ideas in public discourse 

through research, reasoning, organization, composition, delivery to a live audience and 

evaluation of various types of speeches, including informative and persuasive speeches. 

 

• CHEM 123 – Chemistry for Everyone: A beginner-friendly course for non-science majors 

that explores how chemistry connects to everyday life, health, and real-world 

applications. Learn the science behind common experiences and consumer products—

like how shampoo works, why onions make you cry, what’s in tattoos, or what causes 

chemical reactions to change color or glow. Topics include the scientific method, atoms 
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and molecules, the periodic table, bonding, chemical reactions, solutions, acids and 

bases, organic compounds, and radioactivity. Builds scientific understanding, critical 

thinking, and informed decision-making skills. 

 

• Cross Listed Course Example: ETHS 141 - Sociological study of race, ethnicity and 

diversity in American society. Examination of various social conditions that affect the 

ever-changing culture of American society.  Introduction to the field of Ethnic Studies and 

an examination of minoritized/historically marginalized communities in the U.S. 

Identifying the social, political, and economic effects of policies, systems, institutions, 

and social movements. This course is offered as SOCI 141 and ETHS 141. 

Need for the Course 

Explain the necessity of the course within the college curriculum, including how it expands 

equitable access to program pathways and supports degree or certificate completion. Describe 

how the course fulfills program, degree, certificate, or transfer requirements (e.g., AA-T, 

CalGETC, CSU, or UC GE breadth). 

Reference student demand, enrollment trends, and relevant equity data to demonstrate need, 

including any disproportionate impact or gaps in access the course helps address. Clearly 

distinguish the course from existing offerings and use concise, data-informed language aligned 

with institutional goals and student success priorities. Highlight how the course is designed with 

multiple means of engagement and representation to ensure all students, regardless of ability or 

background, can succeed. 

Need for Course example phrasing: 

• ANTH C1001 is associate degree applicable, fulfills requirements for the Associate in 

Arts for Transfer (AAT) in Anthropology, and meets associate degree general education 

requirements. The course transfers to CSU and UC institutions. The course design 

supports accessible, inclusive instruction and promote equitable student success and 

transfer outcomes. 

• ENGL 163 - Chicano/Latino Literature:  This course provides CHC students the 

opportunity to study English-language literature by writers of Mexican and other Latin 

American heritages, including novels, short stories, plays, poetry, and song lyrics. The 

course responds to demonstrated student interest, particularly among those introduced 

to multicultural literature in high school and those seeking focused study of Latino and 

Latina writers in English. This course is associate degree applicable and transfers to UC 

and CSU institutions. The course design supports accessible, inclusive instruction and 

equitable student success. 

Goals for the Course 

Describe how the course supports the college mission by promoting academic excellence, 

critical thinking, lifelong learning, and transfer or career readiness. Clearly explain its distinct 

role within the discipline, including its unique focus, intended audience, and contribution to the 

overall curriculum, such as filling content gaps, building foundational skills, or supporting 

advanced study. Use clear, outcome-oriented language aligned with program learning outcomes 

and institutional goals and reflect the college’s commitment to inclusive practices and equitable 

student success. 
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Goals for Course example phrasing: 

• Prepares students for successful transfer and supports the college mission by providing 

rigorous algebraic foundations aligned with CSU/UC expectations. The course supports 

diverse learners through accessible, thoughtfully designed instruction and builds the 

prerequisite skills required for calculus, statistics, and other STEM pathways. 

• This course supports the college mission by being associate degree applicable, fulfilling 

the associate degree general education requirement for the social sciences, and 

applying to the AA and AA-T degrees in Sociology. It transfers to UC, CSU, and other 

four-year colleges and universities, and is recommended or required for several 

academic and professional programs. 

Content 

Course Content (The "What"): The specific body of knowledge and topics that must be taught. 

Content is the central link; it provides the substance through which Objectives and SLOs are 

realized. Content, in terms of a specific body of knowledge, should depict the scope and depth 

of topics or subjects to be covered by the course.  Instructional Methodology identifies the key 

methods and activities used to deliver instruction, including, but not limited to, lecture, 

laboratory, distance education, and independent study. (PCAH) 

Design and organization should also reflect inclusive practices, incorporating Universal Design 

for Learning (UDL) and Diversity, Equity, Inclusion, Accessibility, and Anti-Racism (DEIAA) 

principles to support access, reduce barriers, and promote equitable student success. Use 

parallel structure, consistent terminology, and a professional format suitable for curriculum 

documentation. 

Content Area: Outline Format the Using CurriQunet Toolbar 

CurriQunet default First Level format uses Numbers. Change this First Level to Upper Alpha 

and if needed, Second Level formatting to Numbers.  

A. Either type in directly or paste unformatted text, then format using the CurriQunet Format on 

the Tool bar.  

1. First Level: Place curser in front of text to be formatted > Select Insert/Remove Numbered 

List from toolbar. The number 1 will need to be changed to Upper Alpha. Now again, place 

curser in front of text to be formatted and right click the text > select Numbered List 

Properties > Select Upper Alpha > OK. 

2. If second level is needed: Change an Upper Alpha to a Number: Place curser in front of 

text to be formatted > indent on the CurriQunet Format on the Tool bar. 
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Student Learning Outcomes and Course Objectives  
 

• Outcomes and objectives should be written in clear, accessible language aligned with 

UDL and DEIAA principles, allowing students to understand expectations and 

demonstrate learning through multiple methods.  

• Learning Outcomes are broad, measurable statements of what students can do to 

demonstrate learning and are assessed through varied methods. 

• Objectives are more specific, detailing what students should know or be able to do by 

the end of the course. 

• Use higher-level Bloom’s verbs (e.g., compare and contrast, analyze) rather than lower-

level terms (e.g., identify). 

• Terminology varies: ACCJC refers to “learning outcomes,” while Title 5 uses “objectives,” 

but both describe measurable statements of student knowledge, skills, or competencies. 

• To meet both accreditation and Title 5 standards, write objectives in measurable 

language consistent with learning outcomes assessment practices. 

Student Learning Outcomes (SLOs) – Writing Guidelines 

•Student Learning Outcomes (The "Evidence of Mastery"): The overarching goals that measure 

how effectively a student has mastered the content. When developing course outcomes, use 

clear, measurable action verbs aligned with appropriate cognitive levels (e.g., apply, analyze, 

evaluate, create), reference Bloom’s Taxonomy. Outcomes should describe the overarching 

abilities students can demonstrate by the end of the course and remain aligned with course 

content, assignments, and evaluation methods. Incorporate UDL and DEIAA principles to 

promote equitable, accessible, and rigorous learning for all students. 

• Ensure outcomes reflect critical thinking and appropriate academic intensity. 

• Support multiple means of engagement and demonstration of mastery (UDL). 

• Encourage inclusive, culturally responsive approaches to learning. 

• Keep the number manageable (generally 3–5 outcomes) reflecting essential 

competencies. 

Example SLO Phrasing:  

• Biology: Analyze basic experimental data to identify patterns and draw evidence-based 

conclusions. 

• Creative Writing: Apply foundational writing strategies to create original pieces that 

communicate ideas clearly. 

• Kinesiology: Compare and contrast movement patterns to evaluate effectiveness and 

safety using foundational principles of anatomy and physiology. 

• Political Science: Evaluate introductory-level political arguments or policies using 

foundational theoretical and empirical criteria. 

These outcomes use action verbs from Bloom’s Taxonomy, support inclusive and accessible 
learning practices, and allow multiple valid ways for students to demonstrate mastery. 

Objectives 
Objectives (The "How Content is Achieved"): The discrete skills and building blocks students 
master while engaging with the content. Course objectives are specific to each course and 
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describe what students should understand or be able to explain by the end of instruction. They may 
be written as phrases and must include higher level action verbs to clearly communicate the 
intended learning outcomes. To meet the requirements of Title 5, objectives must be specific, 
measurable, and aligned with college-level rigor and intensity. 

When writing or reviewing course objectives, consider the following: 
• Do the objectives clearly state what students are expected to do?
• Do they align with the course content, assignments, and Methods of Evaluation in the

Course Outline of Record?
• Is the number of objectives appropriate—sufficient to define the learning expectations

without being overwhelming?

Bloom’s Taxonomy - Action Verbs for SLOs and Outcomes 
(Includes Bloom’s level and suggested assessment types for measurability) 

1. Choose verbs that match the level of learning expected in the course.
2. Pair each verb with a specific, observable assessment to ensure measurability.
3. Avoid vague verbs like “Discuss” or “Collaborate”.
4. Mix levels to ensure progression from knowledge → higher-order skills.

Bloom’s Level Action Verbs Suggested Assessment 
Types 

Remember / Knowledge Define, Identify, Classify 
Quizzes, multiple-choice, 
labeling, flashcards, short 
answer 

Understand / 
Comprehension 

Describe, Explain, Summarize, 
Compare / Contrast 

Essays, short answers, 
discussion responses, 
concept maps 

Apply / Application 
Apply, Use, Solve, Implement, 
Demonstrate, Perform, 
Illustrate 

Problem sets, lab exercises, 
case studies, projects, 
simulations 

Analyze / Analysis 
Analyze, Distinguish, Examine, 
Interpret, Investigate, 
Differentiate, Organize 

Data analysis, research 
reports, diagrams, 
comparative essays, lab 
analysis 

Evaluate / Evaluation 
Evaluate, Critique, Assess, 
Justify, Recommend, Verify, 
Validate 

Critiques, peer review, 
presentations, written 
evaluations, decision-making 
exercises 

Create / Synthesis 
Create, Develop, Construct, 
Design, Compose, Formulate, 
Produce 

Projects, portfolios, design 
assignments, research 
proposals, presentations 

Skills-Based / Hands-On 
Measure, Prepare, Operate, 
Document, Record, Calibrate, 
Execute 

Lab work, practical 
demonstrations, performance 
assessments, simulations 

Communication / 
Collaboration Present, Report, Document 

Oral presentations, reports, 
documentation, structured 
group projects 
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The Principles of Universal Design for Learning (UDL) 

In California, Title 5 course standards incorporate the principles of 

Universal Design for Learning (UDL) , which define how courses must 

accommodate and engage diverse student bodies. A recent revision to 

Title 5, impacting the California Community Colleges, specifies that 

curriculum committees must document procedures to ensure that course 

outlines apply UDL strategies. CAST UDL Guidelines™ 

The UDL framework is centered on three core principles: 

• Multiple means of representation (the "what" of learning): Instructors must present

information in various ways to support different learning styles and needs. Examples

include using a combination of textual, multimedia, and accessible formats like audio

and braille.

• Multiple means of action and expression (the "how" of learning): Learners must be

given alternative ways to act skillfully and demonstrate what they know. This offers

flexibility in how students complete assignments, such as allowing a choice between a

research paper, a presentation, or a video project.

• Multiple means of engagement (the "why" of learning): Courses must tap into

learners' interests and motivate them by offering choices of content, adjustable levels of

challenge, and flexible learning tasks. This helps students connect with the material and

develop learner agency.

Specifically, the revisions to Title 5 outline clear requirements for curriculum committees at 

California Community Colleges:  

• Accommodating and engaging diverse students: Curriculum committees must have

a documented process to confirm that course outlines describe strategies to

accommodate and engage a wide variety of students.

• Promoting equitable outcomes: The standards require course outlines to advance

equitable student outcomes, helping ensure all students have an equal opportunity to

succeed.

• Ensuring accessibility: A documented procedure must guarantee accessibility for all

students, especially those with disabilities. Course outlines must explicitly reflect UDL

strategies to support learner variability and diversity.

Overall purpose of the standards 

The inclusion of UDL principles in Title 5 reflects a broader educational goal in California: to 

proactively design instruction and learning environments that remove barriers rather than 

retrofitting them later. The framework is intended to create inclusive and equitable learning 

opportunities that benefit all students, not just those with identified disabilities.  

https://www.cast.org/what-we-do/universal-design-for-learning/
https://udlguidelines.cast.org/


37 



38 

DEIAA in the Curriculum: Definitions and Implementation 

Integrating Diversity, Equity, Inclusion, Accessibility, and Antiracism (DEIAA) into 
curriculum is a mandate under the latest California Code of Regulations, Title 5 revisions. This 
framework ensures that our Course Outlines of Record (COR) move beyond "neutral" instruction 
to actively dismantle systemic barriers and validate the diverse lived experiences of our students. 

Key Definitions 

The following definitions, aligned with California Community Colleges Chancellor’s Office 
standards, should guide your course development: 

• Diversity: The presence of differences (race, gender, ability, etc.) that enrich the
learning environment.

• Equity: Identifying and removing barriers to ensure students receive specific resources
needed to achieve equal outcomes, rather than providing the "same" to everyone.

• Inclusion: Authentically bringing traditionally excluded groups into the learning process
and sharing power in decision-making.

• Accessibility: Designing curriculum and digital platforms (per Section 508 and WCAG
2.1 Level AA) so students with disabilities have equal access to information and
services.

• Antiracism: The active process of identifying and eliminating racism and bias by
changing systems, practices, and attitudes to redistribute power equitably.

Implementation & Compliance Guidelines 

When updating your Course Proposal, ensure the following sections reflect DEIAA and Title 5 
standards: 

1. Culturally Responsive Content & Pedagogy
Under Methods of Instruction, include diverse perspectives. Move away from strictly
Eurocentric viewpoints and incorporate contributions from scholars of underrepresented
communities. Ensure your Content section reflects a global and inclusive scope.

2. Equitable Methods of Evaluation
Title 5 encourages varied and flexible evaluation. To support equity, move beyond high-stakes
testing. Utilize "Methods of Evaluation" that allow students to demonstrate mastery through
different modalities, such as project-based learning, portfolios, or reflections.

3. Regular and Substantive Interaction (RSI)
For Distance Education, Title 5 requires RSI to prevent student isolation. You must select at
least two interaction methods (e.g., feedback via Canvas SpeedGrader, regularly scheduled
discussions, or proactive announcements) to ensure you are actively engaging with learners.

4. Technical Accessibility
Accessibility must be "built-in" rather than an afterthought. As noted in the Distance Education
section, all resources must afford students with disabilities access "anytime, anywhere" without
outside assistance. This includes:

• Captioned video and audio content.
• Screen-reader compatible document layouts.
• Alternative formats for all essential instructional materials.

Guidance Note: DEIAA integration is a continuous process of refinement. The goal is to create 
a "living" curriculum that evolves alongside the needs and identities of our student body. 

https://sbccd.sandbox.curriqunet.com/Form/Course/Index/12173
https://sbccd.sandbox.curriqunet.com/Form/Course/Index/12173
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Methods of Evaluation 

Methods of evaluation are systematically used to assess Student Learning Outcomes (SLOs) 

and Course Objectives, ensuring they are directly linked to the course content. 

According to the Program and Course Approval Handbook (PCAH), methods of evaluation for 

determining student achievement must include a clear identification and description of the 

specific assessment tools used by faculty. These tools measure student progress toward 

achieving the stated course objectives. It is important to note that passive measures—such as 

merely taking attendance or asking students if they are satisfied with the course—are not 

sufficient to evaluate the extent to which students are mastering the actual learning objectives of 

the course. 

In CurriQunet: Methods of evaluation, along with the percentages, are only to be examples. 

Course Materials 

• Texts and course materials must be provided in accessible formats and use inclusive,

UDL-and DEIAA aligned language where appropriate.

• Instructional materials should be recent (within five years) and aligned with the course’s

required rigor, difficulty, and intensity, unless disciplinary standards justify classic or

legacy works.

• For each Text, complete the section: Show how course materials reflect equity.

Include a brief statement explaining how text reflects equity, representation, and

inclusive perspectives appropriate to the discipline.

o Example phrasing: “OpenStax Anatomy & Physiology (2e) was selected in part

because it integrates diverse clinical examples, inclusive imagery, and accessible

digital formats that support DEIAA principles and equitable student access

aligned with course rigor and UDL standards.”

• Faculty are strongly encouraged to adopt OER or low-cost materials to reduce student

costs and enhance accessibility. Use OER Section and select “Show how course

materials reflect equity” if available. If not then clearly label as OER under “Textbook” or

“Other” in the COR.

o Example phrasing: Gustlin, D. & Gustlin, Z. (2023). Introduction to Art History:
Ancient Art History from the First Artists to the 14th Century, Volume I
(LibreTexts OER)

Intensity – Scope and Rigor 

Title 5, § 55002(a)(2)(C) establishes the standard that degree-applicable credit courses must be 

designed with sufficient scope and rigor to require students to spend additional, independent 

study time beyond class hours. This standard interacts with Title 5, §§ 55002(b) (2)(B) and 

55002.5, where the calculation of units is based on total student learning hours, inclusive of all 

hours spent inside and outside of the class. The COR should provide sufficient scope and rigor 

to account for outside-of-class hours. Grades must be based on demonstrated proficiency in the 

subject matter and the ability to demonstrate that proficiency, at least in part, by means of 

written expression that may include essays, or, in courses where the curriculum committee 

deems them to be appropriate, by problem solving exercises or skills demonstrations by 

students.  
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Typical Out-of-Class Outside of Class Assignments – Writing 

Guidelines 

Typical assignments serve as representative examples to inspire instructors while honoring 

academic freedom. Transfer universities review these examples to verify the course's rigor, 

college-level critical thinking, and depth of independent study. Please ensure descriptions align 

with objectives, incorporate UDL and DEIAA principles through multiple learning 

methods, and include a concise statement on evaluation criteria. 

Time Commitment: Enter hours per week for outside-of-class assignments according to the 

provided chart. Your sample assignment can also include its time commitment.  

Content Entry: Provide brief reading and writing descriptions that clearly demonstrate 

independent study and adhere to the preparation standards outlined above. 

Tool Available: AI to Generate Concise, Title 5–Compliant Assignment 

Descriptions. AI is a tool and not a replacement. Always check and revise before Integrating. 

To ensure Course Outlines of Record (COR) meet Title 5 standards for rigor, intensity, 

measurable outcomes, and Universal Design for Learning (UDL), faculty may use AI tools (such 

as ChatGPT or Gemini) to draft concise assignment descriptions. 

Instructions 

1. Copy one specific course Objective from your COR for the Typical Out-of-Class Reading 

Assignment and another for the Writing Assignment. 

2. Copy the AI Prompt Template below. 

3. Replace the bracketed text with your course objective. 

4. Submit the prompt to the AI tool. 

5. Review and edit for discipline-specific accuracy before submitting to CurriQunet. 

AI Prompt Template – Be sure to proof before integrating into CurriQunet 

“I am a college instructor developing a Course Outline of Record (COR) that must 

comply with Title 5 standards for academic rigor and independent study time. 

Write the assignments directly to the student in concise format suitable for CurriQunet. 

Please write: 

• One Reading assignment based on this Course Objective: [Paste Objective Here]. 

• One Writing assignment based on this Course Objective: [Paste Objective Here]. 

Each assignment must: 

• Include estimated independent study time (in hours). 

• Clearly state what the student will produce (include word count or equivalent). 

• Require critical thinking (analysis, comparison, cause-and-effect, application — 

not simple summary). 

• Include three UDL-aligned submission options that maintain equivalent rigor. 

• Include brief evaluation criteria referencing accuracy, critical thinking, 

terminology, vocabulary, and completeness. 

Keep each assignment concise, clear, student-directed, and appropriate for a COR entry 

field.” 
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Example Typical Out-of-Class Outside of Class Assignment Phrasing 

Reading Assignment #1 

Students will read assigned works representing selected genres (e.g., short fiction, poetry, 

creative nonfiction) and analyze differences between simple and sophisticated writing. 

Independent Study Time: 3–4 hours. 

After completing the reading, produce a 500–700-word analytical response that distinguishes 

between simple and sophisticated writing within the selected genres. Identify specific elements 

such as diction, syntax, imagery, structure, characterization, theme development, and use of 

literary devices. Support your analysis with direct textual examples and explain how craft 

choices affect meaning and reader experience. Summary alone is not sufficient; your response 

must compare and evaluate levels of complexity. 

UDL Submission Options: 

1. Written analytical response (500–700 words). 
2. 6–8-minute recorded presentation with cited textual examples. 
3. Comparative visual chart or slide deck with a 400–600 word or recorded analytical 

explanation. 
All formats must demonstrate equivalent textual analysis and use of literary terminology. 

Evaluation: Accuracy of literary analysis, depth of comparison and evaluation, appropriate use 

of terminology, clarity of explanation, and completeness. 

 

Writing Assignment # 2 

Students will analyze and explain the relationship between a function and its inverse using 

graphical and algebraic reasoning. 

Independent Study Time: 4–5 hours. 

Select two one-to-one functions and explain the relationship between each function and its 

inverse using algebraic and graphical reasoning. Show how you determine each inverse, verify 

the relationship through composition, describe how the graphs are related, and explain how 

domain restrictions address functions that are not one-to-one. Use precise mathematical 

terminology throughout. 

UDL Submission Options: 

1. Written analytical explanation with graphs and algebraic verification (750–1,000 words). 

2. Recorded presentation (8–10 minutes) demonstrating algebraic steps and graphical 

analysis. 

3. Digital slide or whiteboard presentation including graphs, symbolic work, and written or 

recorded explanation equivalent in length. 

All formats must demonstrate equivalent algebraic accuracy and graphical reasoning. 

Evaluation: Accuracy of algebraic procedures and graphs, depth of conceptual analysis, correct 

mathematical terminology, logical organization, and completeness. 
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Writing Assignment #3 

Objective: Outline the arguments supporting various theories explaining the origins of the first 
life on Earth. 
Assignment: 
Research and evaluate major scientific hypotheses explaining the origin of life on Earth (e.g., 
primordial soup/chemical evolution, hydrothermal vent hypothesis, RNA world hypothesis, or 
panspermia). Compare at least two theories, describing the evidence and reasoning 
supporting each. Analyze strengths, limitations, and key differences between the theories, 
and explain how experimental evidence has contributed to current scientific understanding of 
abiogenesis. 
Student Product (choose one): 

• Comparative essay: 600–800 word written analysis comparing at least two origin-of-life 
theories. 

• Comparative chart with analysis: Structured comparison chart of at least two theories 
plus a 300–400 word analytical explanation. 

• Recorded presentation: 5–7 minute audio or video presentation comparing theories 
and discussing supporting evidence (approx. 650-word equivalent). 

Estimated Independent Study Time: 3 hours 
Evaluation Criteria: 
Accuracy of scientific content; quality of comparison and evaluation of theories; correct use of 
biological terminology and vocabulary; logical organization of arguments; completeness and 
clarity of explanation. 

 

Reading Assignment #4: Comparative Reading Log 

Course Objective: Explore feminist movements and compare and contrast these movements 
to other social movements. 

• Task: Read the assigned chapter, "The Long Second Wave," from Global Feminisms: A 
Multiracial History (or equivalent course text). Complete a structured reading log that 
identifies three primary intersectional strategies used by feminist organizers and maps 
them against the tactics used in the 1960s Labor Movement. 

• Independent Study Time: 5 hours (includes active reading, cross-referencing, and 
annotation). 

• Product: Annotated Reading Log (approx. 500–750 words of technical notes/analysis). 
• Critical Thinking Requirement: You must contrast the success of specific legislative 

goals between both movements and analyze how the "cause-and-effect" of socio-
economic status impacted participant mobilization in each. 

• UDL Submission Options: 
1. Annotated Text: A digital or scanned copy of the reading with margin notes and 

a summary table. 
2. Dialectical Journal: A two-column double-entry journal (quotes from text vs. 

student critical analysis). 
3. Graphic Organizer: A detailed Venn diagram or matrix comparing movement 

attributes, supplemented by brief explanatory citations. 
• Evaluation Criteria: Accuracy of historical references; evidence of deep engagement 

with the text; correct application of movement-specific terminology; and completeness of 
the comparison. 
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Six-Year Course Review Requirement 

In accordance with California Code of Regulations, Title 5 §55003, all prerequisites and 
corequisites must be reviewed at least once every six years (more frequently for certain career 
education courses). Because prerequisites, corequisites, and other regulatory elements are 
embedded within the Course Outline of Record (COR), the college conducts a comprehensive 
review of each course at least once every six years. This review ensures that course content, 
objectives, student learning outcomes, methods of evaluation, assignments, and requisites 
remain current, accurate, and compliant with state regulations. 

 
Regular review also supports accreditation standards, articulation agreements (including UC, 
CSU, and C-ID), and transfer expectations, all of which require curriculum to be systematically 
evaluated and kept up to date. The six-year review is not simply a procedural update; it is a 
faculty-driven academic quality assurance process that confirms the course reflects current 
disciplinary standards, maintains appropriate rigor, and continues to meet degree, certificate, 
and transfer requirements. Courses that are not reviewed within the required timeframe may be 
subject to inactivation in order to maintain compliance. 

Groups 

Used in Program Requirements to insert “AND,” “OR,” or “Require” between courses or other 
requirements. 

1. Select +ADD to add courses. 
2. To insert “AND,” “OR,” or “Require,” select +ADD Group. 
3. The Group must be placed above the courses it applies to. To rearrange courses or a 

Group, hover over the series of dots on the left until the hand icon appears, then drag to 
reorder. 

4. To activate the “AND,” “OR,” or “Require” designation, drag the applicable course slightly 
(about one inch) to the right to indent it. Repeat for each course included in the Group. 

5. When completed correctly, “AND,” “OR,” or “Require” will appear in red between the 
courses. 

Deactivating (Deleting) a Course or Program 
Navigation: Curriculum > Course (or Program) > Select your Course (or Program) > Deactivate 
> Create 

 
Course 

Check Impact: Go to Reports > Impact. Review the impact and confirm you want 
to proceed. No rationale is required. Select Launch. 

Honors Course 
1. Check Impact: Go to Reports > Impact. Review the impact and confirm you want 

to proceed. 
2. Enter a Rationale for Course Modification (deletion) in the Cover area. Scroll 

down to the Rationale for Deactivation section. 
3. Select Launch. 

Program 
1. Enter a Rationale for Program Deactivation (deletion) in the Basic Program 

Information area. Scroll down to the Rationale for Deactivation section. 
2. Select Launch. 
Delete a Draft 
Curriculum > Course (or Program) > Select your Course (or Program) > Delete 
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Part 3.C. Programs 

Credit Program Types 

All credit programs must be chaptered by the Chancellor’s Office to appear on a student 
transcript. 

1. Baccalaureate Degrees (BS/BA) 

Community College Baccalaureate programs are designed to meet unmet regional workforce 
needs in high-demand fields. 

• Unit Requirements: A minimum of 120 semester units (or 180 quarter units) total. This 
must include: 

o At least 60 semester units of lower-division coursework. 
o A minimum of 40 semester units of Upper-Division coursework. 

• General Education (Revised): 
o Lower-Division: Must complete the CSU GE-Breadth or CalGETC pattern. 
o Upper-Division: At least 9 semester units of upper-division GE are required. 

• Major Requirements: All upper-division major courses must be completed with a grade 
of "C" or better (or "P"). 

• 2-Year Recency Rule: The program must undergo a board review every two years to 
ensure it continues to meet documented workforce needs. 

2. Associate Degrees for Transfer (AA-T and AS-T) 

Also known as ADTs, these degrees are strictly governed by Senate Bill 1440 and Title 5 § 
55063. 

• Unit Requirements: Exactly 60 semester units (or 90 quarter units) of CSU-transferable 
coursework. 

• Revised GE Standard (CalGETC): Per the latest mandates, ADTs must utilize the 
California General Education Transfer Curriculum (CalGETC) pattern to ensure 
seamless transfer across both UC and CSU systems. 

• Major/Area of Emphasis: Minimum of 18 units in a major defined by the Transfer Model 
Curriculum (TMC). 

• Prohibited Practices: Under the revised standards, colleges cannot impose any 
additional local graduation requirements (e.g., physical education or local history) on 
students earning an ADT. 

• C-ID Requirement: Courses within the major must have an approved C-ID descriptor or 
be submitted for C-ID approval within 45 days of program submission. 

3. Career Technical Education (CTE) Associate Degrees (AA/AS) 

CTE degrees are designed for students seeking lead-in expertise for specific high-wage, high-
growth occupations. These degrees are classified by a vocational Taxonomy of Programs 
(TOP) code. 

• Unit Requirements: Minimum of 60 semester units (or 90 quarter units) of degree-
applicable credit. 

• Major Requirements: Minimum of 18 semester units (or 27 quarter units) in a 
vocational curriculum. 

• Revised GE Standard (CalGETC/Local): While CTE degrees can use a local GE 
pattern, the 2025 Revised Standards encourage alignment with CalGETC to ensure 
future transferability. 

https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
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o Ethnic Studies: Must include a 3-unit transfer-level Ethnic Studies course (Title 
5 § 55063). 

• Two-Year Recency Mandates: 
o LMI: Labor Market Information must be dated within 2 years of submission. 
o Advisory: Must include minutes from an industry advisory committee dated 

within 2 years. 
• Regional Recommendation: Requires a recommendation from the Regional 

Consortium (e.g., LARC) to prevent regional program duplication. 

4. Local Associate Degrees (AA and AS) 

Local degrees are designed to meet specific community needs or for transfer preparation to 
non-CSU/UC institutions. 

• Unit Requirements: Minimum of 60 semester units of degree-applicable credit. 
• Residency Requirement (Revised): At least 12 semester units must be completed in 

residence within the District (broadened from the previous single-college rule). 
• Major/Area of Emphasis: Minimum of 18 semester units in a single discipline or related 

disciplines as listed in the Taxonomy of Programs (TOP). 
• General Education (Revised): 

o Must complete a minimum of 21 semester units of GE (increased from 18 units in 
some categories to align with CalGETC areas). 

o Ethnic Studies: Satisfactory completion of a transfer-level course (min. 3 units) 
is mandatory for all local degrees. 

• Competency Requirements: Students must demonstrate competency in Written 
Expression and Mathematics/Quantitative Reasoning. Under the revised standards, this 
is often satisfied by completing the relevant GE area with a "C" or better. 

5. Certificates of Achievement 

Certificates of Achievement are the only credit certificates that may appear on a student’s official 
transcript. They are designed for quick entry into the workforce or "stacking" toward an 
Associate Degree. 

• Unit Thresholds (Revised): 
o 16+ Semester Units: Must be submitted for state chaptering and receive a COCI 

control number. 
o 8–15.5 Semester Units: Known as "Low-Unit Certificates" or Micro-credentials. 

These may be submitted for state chaptering to appear on transcripts but are not 
required to be. 

• Sequence of Courses: Must represent a well-defined pattern of learning; certificates 
cannot consist solely of basic skills or ESL. 

• CTE vs. Local Certificates: 
o CTE Certificates: Require LMI and Advisory Committee documentation (dated 

< 2 years). 
o Local Certificates: Developed for community needs or transfer (e.g., CSU GE-

Breadth or CAL-GETC certificates). These do not require LMI or Regional 
Consortium approval. 

• Residency: At least 12 units of the certificate must be completed in residence within the 
District (for certificates 16 units or larger). 

 

https://regionalcte.org/about
https://regionalcte.org/about
https://losangelesrc.org/program-recommendation/
https://www.cccco.edu/-/media/CCCCO-Website/docs/curriculum/program-course-approval-handbook-8th-edition.pdf
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Noncredit Program Types (CDCP) 

Noncredit programs do not award units but lead to enhanced funding via Career Development 
and College Preparation (CDCP) status. 

• Certificate of Completion: Focused on short-term vocational skills and immediate 
employability. 

• Certificate of Competency: Focused on ESL or Basic Skills to prepare students for 
credit-level work. 

• Adult High School Diploma: A sequence of noncredit courses leading to a high school 
diploma. 

Program Status and Applicability (Title 5, § 55000) 

I. Program Status 

This element determines if a course is linked to a state-approved program. 

• 1 - Program-applicable: The course is a core requirement or restricted elective for a 

degree or certificate of achievement chaptered by the Chancellor’s Office. For noncredit, 

this includes sequences leading to a Certificate of Competency or Completion. 

• 2 - Not Program-applicable: "Stand-alone" courses that are not part of a state-

approved program. This includes courses for locally approved certificates (under 16 

semester units) that have not been chaptered. 

II. Revised Program Applicability Criteria 

A course is considered program-applicable if it meets one of the following: 

• Major Requirements: Explicitly required for a degree or certificate in a program 

chaptered in the Chancellor’s Office Curriculum Inventory (COCI). 

• Restricted Electives: Listed as an option within a specific program's "required elective" 

block. 

• GE Alignment (REVISED): The course is part of the new CalGETC (California General 

Education Transfer Curriculum) pattern, or a local GE pattern aligned with the 

Modernized Title 5 Associate Degree Standards. 

III. Summary of Key Revisions (2024–2026) 

• Unified GE: Revision of Title 5 § 55063 now prioritizes CalGETC as the singular GE 

pathway for transfer degrees, meaning courses must align with these specific area 

standards to remain "Program-applicable" via GE. 

• Auto-Chaptering: Under the new Annual Certification process, courses submitted as 

part of a new program are granted "Program-applicable" status immediately upon the 

issuance of a control number, provided the college’s curriculum committee has certified 

compliance. 

• Unit Thresholds: While the 16-unit threshold for mandatory state approval remains, the 

revisions encourage colleges to chapter smaller "Micro-credentials" (8–15.5 units) to 

move them from "Not Program-applicable" (2) to "Program-applicable" (1) for better 

student transcripting and funding. 
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Credit CTE Program Criteria & Documentation 

I. The "Two-Year" Rules 

• Labor Market Information (LMI) Recency: To be considered "current" for a new 

program proposal, LMI data requests from the Centers of Excellence (COE) must 

generally be no more than two years old at the time of submission. 

o Note: Some Regional Consortia have moved to an even stricter one-year 

requirement for certain high-demand fields to ensure the data reflects post-2024 

economic shifts. 

• Mandatory CTE Program Review: Under Title 5 § 55003, every CTE program must be 

reviewed by the local governing board every two years to ensure it still meets a 

documented workforce need and maintains high-quality standards. 

• Course Offering Frequency: Colleges must commit to offering all required courses for 

a program at least once every two years so that students can actually complete the 

degree in a timely manner. 

II. Updated Program Narrative & Documentation 

Using the 2025–2026 Revised Standards, your documentation must now include: 

Required Narrative Sections 

1. Goals & Objectives: Must now explicitly address Equity—how the program will close 

achievement gaps for underserved students. 

2. Catalog Description: Must include Student Learning Outcomes (SLOs) and clearly 

state any industry certifications students will be prepared to take. 

3. Program Requirements: A table showing the sequence of courses, now aligned with 

the CalGETC GE pattern. 

4. Master Planning: Must explain how the program fits the college’s "Strong Workforce" 

and "Perkins V" local plans. 

Required Attachments 

• Current LMI (dated within 2 years): Evidence of "High-Wage" or "In-Demand" status. 

• Advisory Committee Minutes: Must be recent (ideally within the last year) and 

explicitly show a motion and vote to recommend the specific program title being 

submitted. 

• Regional Consortium Recommendation: A record of the vote from your regional body 

(e.g., BACCC, SCCRC, etc.). 

• CORs (Course Outlines of Record): Must demonstrate Universal Design for 

Learning (UDL) and include "Total Student Learning Hours" (calculated as Outside-of-

class Hours + Contact Hours). 

https://coeccc.net/
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III. Summary of the Revised Approval Process 

Step Milestone Requirement 

1 LMI Request Request data from COE; must be < 2 years old for submission. 

2 
Advisory 

Meeting 
Industry experts review curriculum and vote to approve. 

3 Regional Review 
Regional Consortium reviews for duplication; issues 

recommendation. 

4 Board Approval Local Board of Trustees approves the narrative and curriculum. 

5 
State 

Submission 

Upload to COCI; Chancellor’s Office issues a unique control 

number. 

 

Noncredit CTE Program Criteria & Documentation 

I. CDCP Eligibility & Award Types 

To qualify for enhanced funding and state approval, noncredit CTE must lead to one of two 

specific awards: 

• Certificate of Completion: For programs leading to improved employability or job 

opportunities (Short-term Vocational). 

• Certificate of Competency: For programs that prepare students to transition into 

degree-applicable credit coursework (Workforce Preparation). 

II. Required Documentation for New Programs 

• Program Narrative: Must explicitly state how the program leads to one of the outcomes 

in § 55151 (employability or credit-readiness). 

• Course Outlines of Record (CORs): All courses in the sequence must be included. 

• Labor Market Information (LMI): Must be dated within 2 years. It must demonstrate 

"high employment potential" or a regional gap in trained workers. 

• Advisory Committee Minutes: Must show a clear motion and vote recommending the 

noncredit program. These should be dated within 2 years. 
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• Regional Consortium Review: Note: While many regions require a recommendation 

for noncredit CTE, some (like LARC) may have different internal tracking for noncredit 

versus credit. Check your local Regional Consortium rules for specific noncredit bylaws. 

III. Noncredit CTE Program Narrative Sections 

1. Statement of Program Goals and Objectives: Must identify the specific TOP Code 

and occupational goal. 

2. Catalog Description: Must include program requirements and Student Learning 

Outcomes (SLOs). 

3. Program Requirements Table: Must list courses and the total number of hours 

required for completion (instead of units). 

4. Master Planning: Explanation of how the program fits the college’s mission and 

regional workforce needs. 

 

IV. Summary of Differences: Credit vs. Noncredit CTE 

Requirement Credit CTE (AA/AS) Noncredit CTE (Cert) 

Primary Measure Semester/Quarter Units Instructional Hours 

Minimum Hours N/A (usually 60 units) Minimum two courses in a sequence 

GE Pattern CalGETC or Local GE No GE Required 

Approval Path Board > Region > State 
Board > State (Regional optional in some 

areas) 

Funding Credit Apportionment CDCP Enhanced Funding 

 

https://losangelesrc.org/program-recommendation/
https://regionalcte.org/about
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